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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notices 

© Copyright 2003 - 2009 Hewlett-Packard Development Company, L.P.


This product includes Xerces XML Java Parser software, which is Copyright (c) 1999 The Apache Software

Foundation. All rights reserved. 


This product includes JDOM XML Java Parser software, which is Copyright (C) 2000-2003 Jason Hunter &

Brett McLaughlin. All rights reserved.


This product includes JClass software, which is (c) Copyright 1997, KL GROUP INC. ALL RIGHTS 

RESERVED.


This product includes J2TablePrinter software, which is © Copyright 2001, Wildcrest Associates (http://

www.wildcrest.com)


This product includes Xalan  XSLT Processor software, which is  Copyright (c) 1999 The Apache Software 

Foundation.  All rights reserved.


This product includes EXPAT XML C Processor software, which is Copyright (c) 1998, 1999, 2000 Thai Open

Source Software Center Ltd and Clark Cooper Copyright (c) 2001, 2002 Expat maintainers.


This product includes Apache SOAP software, which is Copyright (c) 1999 The Apache Software Foundation.

All rights reserved.


This product includes O'Reilley Servlet Package software, which is Copyright (C) 2001-2002 by Jason Hunter, 

jhunter_AT_servlets.com.All rights reserved. 


This product includes HTTPClient Package software, which is Copyright (C) 1991, 1999 Free Software 

Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA  02111-1307 USA.


This product includes Perl software, which is Copyright 1989-2002, Larry Wall. All rights reserved.


This product includes Skin Look And Feel software, which is Copyright (c) 2000-2002 L2FProd.com. All rights 

reserved.


This product includes nanoXML software, which is Copyright (C) 2000 Marc De Scheemaecker, All Rights 

Reserved.


This product includes Sixlegs PNG software, which is Copyright (C) 1998, 1999, 2001 Chris Nokleberg


This product includes cURL & libcURL software, which is Copyright (c) 1996 - 2006, Daniel Stenberg,

<daniel@haxx.se>. All rights reserved.


This product includes Quartz - Enterprise Job Scheduler software, which is Copyright 2004-2005

OpenSymphony
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This product includes Free DCE software, which is (c) Copyright 1994 OPEN SOFTWARE FOUNDATION, 
INC., (c) Copyright 1994 HEWLETT-PACKARD COMPANY, (c) Copyright 1994 DIGITAL EQUIPMENT 
CORPORATION, Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, 
Boston, MA  02111-1307 USA 

This product includes DCE Threads software, which is Copyright (C) 1995, 1996 Michael T. Peterson 

This product includes Jboss software, which is Copyright 2006 Red Hat, Inc. All rights reserved. 

This product includes org.apache.commons software developed by the Apache Software Foundation (http:// 
www.apache.org/). 

Trademark Notices 

Java™ is a U.S. trademark of Sun Microsystems, Inc. Java™ and all Java based trademarks and logos are 

trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. and other countries.


Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California. 


UNIX® is a registered trademark of The Open Group.


Windows® and Windows NT® are U.S. registered trademarks of Microsoft Corporation. 
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Documentation Updates 

This guide’s title page contains the following identifying information: 

• Software Version number, which indicates the software version. 

• Document Release Date, which changes each time the document is updated. 

• Software Release Date, which indicates the release date of this version of the software.


To check for recent updates, or to verify that you are using the most recent edition of a document, go to:


http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.


You will also receive updated or new editions if you subscribe to the appropriate product support service.


Contact your HP sales representative for details.
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Support 

You can visit the HP Software Support Online web site at: 

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers. 

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the HP Software Support web site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training


Most of the support areas require that you register as an HP Passport user and sign in. Many also require a


support contract.


To find more information about access levels, go to:


http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 
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1 Overview 

This chapter covers the following topics: 

• Introduction to HP Performance Insight 

• System Resource Report Pack 

• Generic reports 

• Enhancements in version 4.50 

• Integration with HP Operations 

• Sources for additional information 

HP Performance Insight 

HP Performance Insight collects data from many sources, performs in-depth trend analysis, 
maintains performance baselines, and provides users with convenient, web-based reporting. 
Following is a partial list of product features: 

• Distributed architecture 

• Easy to scale (supports data collection from thousands of agents) 

• CODA/PA agent support 

• Multi-company security model 

• Data warehousing 

• Near Real Time reporting 

• Forecasting 

• Extensive aggregation (by day, week, month; by location, by customer) 

• Thresholding and alerting 

• Easy identification of bottlenecks 

• Easy assessment of capacity trends 

• Accurate and timely documentation for management 

• Integration with NNM 

• Integration with HP Operations 

The reporting solutions created for Performance Insight cover many areas of business 
technology optimization and several new reporting solutions are added every year. 
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System Resource Report Pack 

The reports in System Resource will help you anticipate resource issues before they become 
serious. You will know whether resources are plentiful, limited, or somewhere in between, and 
you will be able to make useful comparisons. For example, you can look at hourly utilization 
levels for yesterday, and if something does not look quite right, you can easily compare 
yesterday’s performance to weekly and monthly trends. You can also compare total CPU 
utilization to the amount of CPU used by a single process. If your systems are seeing high 
utilization, you can use the forecast reports to predict when a performance threshold will be 
reached if current trends continue. 

The System Resource Report Pack includes a main package, multiple sub-packages, and 
multiple datapipes. There are actually three datapipes for the main package—one that 
discovers HP agents, one that polls HP agents, and one that collects data from any system 
that supports the Host Resources MIB. Each sub-package has its own built-in datapipe. For 
more information about datapipes and the metrics each datapipe collects, see Chapter 4, Data 
Collection. 

HP Performance Agents and HP Operations Agents support HTTPS protocol for secure 
communication. As HTTPS communication is certificate-based, you must install certificates 
must be installed on your PI system (including remote pollers) that collects data from agents. 
PI utilizes the client certificates already installed for the agents. The PI system acts as a 
certificate client and the certificate server (certificate authority) is provided by the HP 
management server or HP Performance Agent systems. The client certificates must be 
exchanged to establish HTTPS communication. In some network configurations, multiple 
certificate servers may supply the required certificates for the agents. In this scenario, you 
should obtain trusted certificates from all the certificate servers for the respective agents. 
This can be performed using the Certificate Management application provided in the PI 
Management Console. For more information on the Certificate Management application, see 
HP Performance Insight Administration Guide. 

Following is an alphabetical list of reports in the main package: 

1 CPU Utilization Resource Forecast 

2 Filesystem Utilization Resource Forecast 

3 Filesystem Resource Optimization 

4 Memory Utilization Resource Forecast 

5 Memory Resource Optimization 

6 Service Level Management Executive Summary 

7 System Availability 

8 System CPU, Memory, and Swap Utilization Exception Hot Spots 

9 System CPU, Memory, and Swap Utilization QuickView 

10 System CPU, Memory, and Swap Utilization QuickView - Snapshot 

11 System CPU, Memory, and Swap Utilization QuickView - Near Real Time 

12 System CPU, Memory, and Swap Utilization QuickView - Near Real Time - Snapshot 

13 System Inventory 

14 System Performing Each Application — Snapshot 

15 System Volume and CPU Utilization Top Ten 

16 Top Ten Transaction 
Chapter 1 12 



17 Transactions per System — Snapshot 

Generic Reports 

System Resource includes the following generic report types: 

• Top Ten 

• Hot Spots 

• QuickView 

• Near Real Time 

• Executive Summary 

• Forecast 

If you want to find out where volume and utilization are the heaviest, open the Top Ten 
report. This report sorts systems by volume (highest to lowest), by CPU utilization (highest to 
lowest), and by filesystem utilization (highest to lowest), allowing you to see which systems, if 
any, are experiencing unusual activity. 

If you see a system in the Top Ten report that needs further investigation, open the Snapshot 
version of the QuickView and select the system or systems that interest you. This report 
provides utilization averages for yesterday, shows you what the exception thresholds are, and 
provides graphs that track utilization levels on an hourly basis. 

If you want to see recent performance data that has not been aggregated into hourly averages, 
open the Near Real Time version of the QuickView. By looking at actual sample data 
collected over the previous six hours, you can find out whether a bad condition is improving or 
worsening. If the QuickView is showing over-utilization, use the Optimization reports to see 
whether simple load balancing might be the easiest way to improve service quality. 

If you suspect that utilization levels are high and getting worse, use the Forecast reports to 
pinpoint systems that may be headed toward high utilization. Look for these metrics: 

• Days to Threshold (DTT) 

• Estimated utilization 30, 60, and 90 days from today 

• Grade of Service scores for the previous 24 hours 

• CPU, memory, swap, and filesystem utilization trends over the previous 24 hours 

Enhancements in Version 4.50 

New Prerequisites: 

• Performance Insight 5.40 

• Common Property Tables 3.90 
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New Upgrade Packages 

Upgrade Package Name Version Number 

SystemResource_Upgrade_45 4.50


SystemResourceCPU_Upgrade_to_43 4.30


SystemResource_Disk_Upgrade_to_45 4.50


SystemResource_FileSystem_Upgrade_to_11 1.10


SystemResourceLS_Upgrade_to_11 1.10


SystemResource_LogicalVolume_Upgrade_to_44 4.40


SystemResourceProcess_Upgrade_to_43 4.30


SystemResource_NetInterface_Upgrade_to_44 4.40


SystemResource_Thresholds_Upgrade_31_to_32 3.20


SysRes_RFC1514_Datapipe_Upgrade_to_42 4.20


SysRes_OVPA_Datapipe_Upgrade_to_33 3.30


Defect Fixes 

For a list of defect fixes in this release, see Version History. 

Integration with HP Operations 

You can isolate faults and diagnose problems faster by integrating System Resource with HP 
Operations. To do that, install the thresholds sub-package that comes with System Resource.  
The thresholds sub-package contains a thresholds policy used by the Thresholds Module to 
monitor the database for threshold breaches. 

When the Thresholds Module detects a breach, it takes one of several possible actions. The 
default action is to send a breach trap to Network Node Manager (NNM). When the condition 
clears, the default action is to send a clear trap to NNM. 

Because NNM is the default destination for traps, you must configure the Thresholds Module 
to send traps to HP Operations. To make this change, open the SNMP Trap Action Definition 
form, fill in the necessary information, and save your changes. In addition, the HP Operations 
administrator must create a trap template definition for HP Operations. For details about 
defining the trap template, see The Thresholds Module User Guide. 

Sources for Additional Information 

This user guide includes samples of some of the reports in System Resource. The demo package 
that comes with System Resource contains a sample of every report in the package. If you have 
access to the demo package and you want to know what fully-populated reports look like, install 
the demo package. Like real reports, demo reports are interactive; unlike real reports, demo 
reports are static. 

The following documents are related to this manual: 

• System Resource Report Pack Release Notes 

• SysRes OVPA Datapipe User Guide (formerly Understanding the OVPA Datapipe) 
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• SysRes OVPA Datapipe Release Notes 

• OVPA Collection Datapipe Release Notes 

• SysRes RFC1514 Datapipe Release Notes 

• Metrics for HP Performance Agent and Operations Agent 

• PI Report Packs, CD-ROM Release Notes, February 2009 

You can download the documents listed above from this site: 

http://h20230.www2.hp.com/selfsolve/manuals 

The user guides for PI are listed under Performance Insight. The user guides for report packs 
and datapipes are listed under Performance Insight Report Packs. Each document indicates the 
date. If a document is revised and reposted, the date will change. Since we post revised 
manuals on a regular basis, you should check this site for updates. 
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2 Upgrade Install

This chapter covers the following topics: 

• Guidelines for a Smooth Upgrade 

• Upgrading to System Resource Version 4.50 

• Post-Installation Steps 

Guidelines for a Smooth Upgrade 

The report pack CD contains datapipes, report packs, and several shared packages. When you 
insert the report pack CD in the CD-ROM drive and launch the package extraction program, 
the install script extracts every package from the CD and copies the results to the Packages 
directory on your system. After the extract finishes, the install script prompts you to start 
Package Manager. Before using Package Manager, review the following topics: 

• Software prerequisites for System Resource 

• Datapipes and remote pollers 

• Deleting custom table view 

• Latest version numbers for packages and sub-packages 

Software Prerequisites 

System Resource has the following prerequisites: 

• Performance Insight 5.40 

• All service packs available for PI 5.40 

• Common Property Tables 3.90 

If you are running an earlier version of Common Property Tables, upgrade to Common 
Property Tables 3.90 by installing its version 3.90 upgrade package. Upgrade Common 
Property Tables before upgrading the System Resource Report Pack. 

Datapipes and Remote Pollers 

Datapipes cannot be upgraded. You must remove the existing datapipe, then re-install the 
latest version of the datapipe after the upgrade is complete. When you uninstall an existing 
datapipe, the following information will be lost: 

• The polling policy for a single remote poller 

• Cloned polling policies for multiple remote pollers 
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• Polling groups you created yourself 

To export existing polling policy configurations and customized polling group, use the 
collection_manager and group_manager commands. 

Exporting Polling Policy Configurations 

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export exiting policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME 

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst 

Windows: As Administrator, launch a command window. Navigate to the PI install directory 
and execute the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst 

Exporting Customized Polling Groups 

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, execute the following command: 

cd $DPIPE_HOME 

./bin/group_manager -export_all -outfile /tmp/savePollingGroups 

Windows: As Administrator, launch a command window, then navigate to the PI install 
directory and execute the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups 

Custom Table Views 

If you created custom table views, the views you created may interfere with the report pack 
upgrade, causing the upgrade to fail. Whether or not your custom table views interfere with 
the upgrade depends on how you created them. If you created them using SQL, the upgrade 
will succeed but your custom views will not be available once the upgrade is complete. If you 
created them using Datapipe Manager, the upgrade is likely to fail. To prevent the upgrade 
from failing, delete your custom table views before upgrading the report pack, then recreate 
these views after the upgrade is complete. 

Version Numbers for Packages and Datapipes 

Base Package Name 

SystemResource 

SystemResourceCPU 

SystemResource_Disk 

SystemResource_FileSystem 

Version 

4.50 

4.30 

4.50 

1.10 
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Base Package Name 

SystemResourceLS 

SystemResource_LogicalVolume 

SystemResource_NetInterface 

SystemResourceProcess 

SysRes_OVPA_Datapipe 

SysRes_RFC1514_Datapipe 

OVPA_Collection_Datapipe 

SystemResource_Thresholds 

• UPGRADE_SR_to_45.ap 

• UPGRADE_SR_CPU_to_43.ap 

• UPGRADE_SR_DISK_to_45.ap 

• UPGRADE_SR_FS_to_11.ap 

• UPGRADE_SR_LS_to_11.ap 

• UPGRADE_SR_LV_to_44.ap 

• UPGRADE_SR_NI_to_44.ap 

Version 

1.10 

4.40 

4.40 

4.30 

3.30 

4.20 

1.00 

3.20 

• UPGRADE_SR_PROC_to_43.ap 

• UPGRADE_SR_OVPA_to_33.ap 

• UPGRADE_RFC1514_to_42.ap 

• UPGRADE_SR_Thresholds_31_to_32.ap 

Upgrading to System Resource Version 4.50 

Follow these steps to upgrade the System Resource Report Pack. Since your existing 
datapipes cannot be upgraded, they must be uninstalled before you upgrade the report pack, 
then reinstalled after the report pack is upgraded. 

1 Log in to the system. On UNIX systems, log in as root. 

2 Stop OVPI Timer and wait for processes to stop running. 

Windows NT: 

a Select Control Panel > Administrative Tools > Services 

b Select OVPI Timer from the list of services. 

c From the Action menu, select Stop.


UNIX: As root, do one of the following:


— HP-UX: sh /sbin/init.d/ovpi_timer stop 

— Sun: sh /etc/init.d/ovpi_timer stop 
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3 If necessary, upgrade Common Property Tables by installing its version 3.90 upgrade 
package. When you install the upgrade, do not install other packages at the same time. 
Install the upgrade for Common Property Tables and only the upgrade for Common 
Property Tables. If you need help with the upgrade, refer to the Common Property Tables 
User Guide. 

4 Install the upgrade package for the SR report pack: 

• SystemResource_Upgrade_45 

5 Install these upgrade sub-packages: 

• SystemResourceCPU_Upgrade_to_43 

• SystemResource_Disk_Upgrade_to_45 

• SystemResource_FileSystem_Upgrade_to_11 

• SystemResourceLS_Upgrade_to_11 

• SystemResource_LogicalVolume_Upgrade_to_44 

• SystemResourceProcess_Upgrade_to_43 

• SystemResource_NetInterface_Upgrade_to_44 

• SystemResource_Thresholds_Upgrade_31_to_32


6 Install one of these upgrade packages:


• SysRes_OVPA_Datapipe_Upgrade_to_33 

or 

• SysRes_RFC1514_Datapipe_Upgrade_to_42


7 Restart OVPI Timer.


Windows NT: Select Settings > Control Panel > Administrative Tools > Services 

UNIX: As root, type one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer start


Sun: sh /etc/init.d/ovpi_timer start


Post-Installation Steps 

Reconfigure any polling policies and customized group definitions that need to be restored. Do 
not re-import the configurations you exported. Because the old datapipe may be incompatible 
with the new datapipe you just installed, re-importing the configurations you exported could 
lead to data corruption. In addition, if you dropped any custom table views, you may recreate 
those custom views now. 
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3 The New Install 

This chapter covers the following topics: 

• Guidelines for a smooth install 

• Installing System Resource 

• Accessing deployed reports 

• Seeing performance data in reports 

Guidelines for a Smooth Install 

The applications that run on Performance Insight have two ingredients, a report pack and at 
least one datapipe. When you install the datapipe, you configure PI to create tables and to 
collect a specific type of performance data at a specific interval. When you install the report 
pack, you configure PI to create tables, process data collected by the datapipe, and aggregate 
data in some manner, for example, by month, by location, or by customer. 

The report pack CD-ROM contains report packs and datapipes. When you insert the CD in the 
CD-ROM drive and launch the package extraction program, the install script extracts every 
package from the CD and copies the results to the Packages directory on your system. After 
the extract finishes, the install script prompts you to start Package Manager and follow the 
on-screen instructions. Before using Package Manager, review the following guidelines. 

Software Prerequisites 

System Resource has the following prerequisites: 

• Performance Insight 5.40 

• All service packs available for PI 5.40 

• Common Property Tables 3.90 

If you are not running any version of Common Property Tables, let Package Manager install 
Common Property Tables for you. If you are running an earlier version of Common Property 
Tables, upgrade to the latest version by installing its 3.90 upgrade package. Upgrade 
Common Property Tables before installing the System Resource Report Pack. 

Datapipes and Datapipe Dependencies 

The datapipes that collect data for System Resource are not prerequisites. You may install the 
datapipes when you install System Resource or you may install the datapipes after you install 
System Resource. These are your options: 

• RFC 1514 Datapipe (host resources MIB) 
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• SR OVPA Datapipe 

Because the SR OVPA Datapipe depends on the OVPA Collection Datapipe to perform agent 
discovery, the OVPA Collection Datapipe is a prerequisite for the SR OVPA Datapipe. If you 
select the SR OVPA Datapipe for installation, Package Manager will select and install the 
OVPA Collection Datapipe for you, automatically. 

If desired, you may install all three datapipes. If you install all three, do not allow the RFC 
1514 Datapipe and the SR OVPA Datapipe to collect data from the same node. Node 
configuration must be set for one datapipe exclusively, not both. If node configuration is not 
exclusive, you could get multiple fsindex values for the same node_fk. 

Thresholding and Integration with HP Operations 

If you want to implement thresholding for the reports in the main package, install 
SystemResource_Thresholds. The package contains customized thresholds. Installing the 
thresholds sub-package configures PI to monitor the database for threshold conditions and 
respond to a breach condition by taking one of several possible actions. 

The thresholds sub-package reports exceptions on aggregated data, on hourly data, or on both 
aggregated data and hourly data. 

The thresholds sub-package requires the Thresholds Module. If you select the thresholds 
sub-package for installation, Package Manager will select and install the Thresholds Module 
for you, automatically. Because the Thresholds Module includes defaults designed for NNM, 
you must configure the Thresholds Module to send breach traps to HPOU or HPOW. For 
details about destination parameters, as well as category and severity parameters, see the 
Thresholds Module User Guide. 

Distributed Environments 

Central server software requirements are different from satellite server software 
requirements. Install the following packages on the central server: 

• System Resource 

• Optional sub-packages (SR_CPU, SR_DISK, etc.) 

• Common Property Tables 


Install the following packages on each satellite server:


• System Resource 

• Optional sub-packages (SR_CPU, SR_DISK, etc.) 

• Common Property Tables 

• Datapipes: 

— SysRes OVPA Datapipe and 

— OVPA Collection Datapipe 

or 

— SysRes RFC 1514 

• SystemResource_Thresholds (optional) 

• Thresholds Module (optional) 
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If you are only interested in seeing alarms on hourly data, installing the thresholds 
sub-package on the central server is not necessary. If you want to set thresholds on 
aggregated data, you must install the thresholds sub-package on the central server. 

When you finish installing packages, configure your central server and each satellite server. 
For details, see Chapter 5, Setting Up a Distributed System. 

Installing System Resource 

Follow these steps to install System Resource: 

•	 Task 1: Stop OVPI Timer and extract packages from the report pack CD. 

•	 Task 2: Install System Resource, optional sub-packages, and at least one datapipe 

•	 Task 3: Restart OVPI Timer. 

Task 1: Stop OVPI Timer and extract packages from the report pack CD 

1 Log in to the system. On UNIX systems, log in as root.


2 Stop OVPI Timer and wait for processes to terminate.


Windows: Do the following:


a	 Select Control Panel > Administrative Tools > Services 

b Select OVPI Timer from the list of services.


c From the Action menu, select Stop.


UNIX: As root, do one of the following:


—	 HP-UX: sh /sbin/init.d/ovpi_timer stop 

—	 Sun: sh /etc/init.d/ovpi_timer stop 

3	 Insert the report pack CD in the CD-ROM drive.


Windows: A menu displays automatically.


UNIX:


a Mount the CD (if the CD does not mount automatically). 

b Navigate to the top level directory on the CD. 

c Run ./setup 

4	 Type 1 in the choice field and press Enter. 

The install script displays a percentage complete bar. When the copy is complete, the 
install script starts Package Manager. The Package Manager welcome window opens. 

Task 2: Install System Resource and at least one datapipe 

1 Click Next. The Package Location window opens. 

2 Click Install. Approve the default destination directory or browse to a different directory if 
necessary. 

3 Click Next. The Report Deployment window opens. Type your username and password for 
the PI Application Server. 
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4 Click Next. The Package Selection window opens. Click the check box next to: 

•	 System Resource 4.50 

•	 SR_LS sub-package 1.10 (optional) 

•	 SR_LS_Thresholds 1.00 (optional) 

•	 SR_LV sub-package 4.40 (optional) 

•	 SR_PROC sub-package 4.30 (optional) 

•	 SR_NetIf sub-package 4.40 (optional) 

•	 SR_CPU sub-package 4.30 (optional) 

•	 SR_DISK sub-package 4.50 (optional) 

•	 Datapipes: 

—	 SR OVPA Datapipe 3.30 

—	 OVPA Collection Datapipe 1.00 

—	 SysRes RFC1514 Datapipe 4.10 

•	 SystemResource_Thresholds 3.20(optional) 

Installing SystemResource_Thresholds is optional. If you install the 
thresholds sub-package, Package Manager will install Thresholds Module for 
you. 

If you are not currently running any version of Common Property Tables, 
Package Manager will select and install Common Property Tables for you, 
automatically. 

The demo package is optional. You can install the demo package and nothing 
else, or you can install the demo package along with everything else. 

5	 Click Next. The Type Discovery window opens. Disable the default and click Next. The 
Selection Summary window opens. 

6	 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package installation complete message appears. 

7	 Click Done to return to the Management Console. 

Task 3: Restart OVPI Timer 

Windows NT: Select Settings > Control Panel > Administrative Tools > Services 

UNIX: As root, type one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer start


Sun: sh /etc/init.d/ovpi_timer start
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Accessing Deployed Reports 

When you installed this report pack, you enabled the Deploy Reports option. As a result, the 
reports in this package (as well as any forms that come with this package) are now deployed to 
the PI Application Server. Once reports reside on the PI Application Server, you can view 
them on the web or you can view them using the PI client applications. 

The clients are Report Viewer, Report Builder, and the Management Console. If the clients are 
not installed on your system, you must use a web browser to view reports. For more 
information about the application clients, see the PI Installation Guide. For more information 
about the Management Console, including how to use the Object/Property Management view 
to launch reports specific to a selected object, see the PI Administration Guide. 

Seeing Performance Data in Reports 

Some reports populate with data sooner than others. The first report to populate with data is 
the Near Real Time report. You will begin to see data in this report immediately after the first 
data collection completes. 

Any report that begins with an analysis of yesterday’s performance will need at least one full 
day’s worth of data before results are viewable. You will begin to see forecast data soon, within 
a few days. However, reliable forecast data will not be available until the baseline is complete, 
and completing the baseline will take several weeks. 
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4 Data Collection 

This chapter covers the following topics: 

•	 SysRes RFC 1514 Datapipe 4.00 

•	 OVPA Collection Datapipe 1.00 

•	 SysRes OVPA Datapipe 3.00 

•	 Data collected by the following sub-packages:


— CPU 


— Process


— Disk 


—	 Logical Volume 

—	 Network Interface 

—	 Logical System 

SysRes RFC1514 Datapipe 

The SysRes RFC 1514 Datapipe collects the following data from the Host Resources MIB: 

•	 CPU utilization 

•	 Memory utilization 

•	 Number of page outs 

•	 Run queue length 

•	 Swap utilization 

OVPA Collection Datapipe 

The OVPA Collection Datapipe performs the following tasks: 

•	 Discovers PA or EPC performance agents 
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• Inserts pa_collect statements into the trendtimer.sched file 

In 

In a distributed environment, remote pollers sometimes do not refresh the 
trendtimer.sched file with new pa_collect  statements at different intervals. 

To configure a remote poller for refreshing the pa_collect entries, you must edit the 
trendtimer.sched file on remote poller with the following entries: 

5 - - {DPIPE_HOME}/bin/pa_collect -n -i 5 -E 5 

10 - - {DPIPE_HOME}/bin/pa_collect -n -i 10 -E 10 

15 - - {DPIPE_HOME}/bin/pa_collect -n -i 15 -E 15 

20 - - {DPIPE_HOME}/bin/pa_collect -n -i 20 -E 20 

60 - - {DPIPE_HOME}/bin/pa_collect -n -i 60 

24:00+1:00 - - {DPIPE_HOME}/bin/pa_collect -n -i 1440 

•	 Populates the PA type group for use in the collection process 

The discovery process runs once a day. In accordance with directives in the 
OVPA_Collection_Daily.pro file, the discovery process attempts to check all of the nodes in 
ksi_managed_node table. Since SNMP discovery can only discover SNMP-pollable devices, 
you may want to add PA or EPC systems using the create node tool. 

Once the discovery process starts, it writes to the pa_discovery.data file in the DPIPE_HOME/ 
data directory. The pa_discovery.data file contains the systems the discovery process finds. 
Once the discovery process is complete, ee_collect loads the pa_discovery.data file into PI. The 
data is placed in the K_padatasources table. 

Sometimes data batches collected every 15 seconds from PA agents using SR_OVPA Datapipe 
fails to sum up correctly. This happens when the SR_OVPA Datapipe collects data every 15 
seconds from PA agents. However, while summarizing the data by ta_period, trend_sum 
utility sums four batches of fifteen second data samples to one minute data. This often causes 
data to be represented wrongly. For example, if four batches of CPU utilization data are 
summed up, the CPU utilization for one minute often shows to be greater than 100%. 
To solve this problem: 
1 Run the following command: 

trend_sum –U 

The option –U enables trend_sum to process all the data residing in the source table 
ignoring the timestamps of data batches. For more information about this option refer to 
trend_sum in HP Performance Insight Reference Guide. 

2 Check the data generated by trend_sum. 

•	 If this data is correct, 

a Open the OVPA_Collection_Daily.pro file. 

b Update the entry for the trend_sum utility as follows: 

trend_sum -P 60 

The option –P 60 compels trend_sum to wait for 60 minutes before processing the 
collected data. This option ensures that trend_sum would process the data batches 
with timestamps older than 60 minutes. For more information about this option refer 
to trend_sum in HP Performance Insight Reference Guide. 

•	 If the result generated by trend_sum is not correct, trend_sum utility may not be 
running correctly. In such case contact HP Support. 
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SysRes OVPA Datapipe 

The SysRes OVPA Datapipe collects metrics from the following classes: 

• Global 

• Filesystem 

• Application 

• Transaction 

• Configuration 

Metrics in the configuration class are collected once daily. The other classes are collected 
hourly. All class are collected from two agents: 

• HP Performance Agent (PA) 

• Embedded Performance Component of HP Operations (HP OA) 

HP OA, also known as EPC, ships with HPOU 7.0 and HPOW 7.0. If you are using HPOU 7.0 
(or later) or HPOW 7.0 (or later), the SysRes OVPA Datapipe collects metrics from EPC. If you 
are using an earlier version of HP OA, the SysRes OVPA Datapipe collect metrics from PA. 

The metrics gathered by PA are different from the metrics gathered by EPC. For details about 
how the metrics vary, refer to Metrics for HP Performance Agent and Operations Agent. You 
can download this document from the Product Manuals website. Look for it in one of two 
places, under Operations for Windows or under Operations for UNIX. 

For more information about the SysRes OVPA Datapipe, including information about tables, 
metrics, and mapping, refer to System Resource OVPA Datapipe User Guide. 

Collections Performed by Sub-Packages 

The following sub-packages can be installed with the System Resource Report Pack: 

1 CPU 

2 Process 

3 Disk 

4 Logical Volume 

5 Network Interface 

6 Logical System 

Each sub-package provides a built-in data collection. Each collection takes place hourly. In 
addition, each collection is a history-styled collection. When the system is polled, the datapipe 
returns multiple rows, with each row having a distinct ta_period. The first time the collection 
runs, all rows from midnight of the previous day will be returned. Each collection thereafter 
will only return data that has not already been collected. 

Limiting subsequent collections to data that has not already been collected is accomplished 
using history property tables. These tables contain the last ta_sysuptime value in the lastPoll 
column. Each collection after the first collection asks for data with a time stamp value greater 
than the value in lastPoll. 
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1. CPU Sub-Package 

The CPU sub-package collects data from the CPU class. All systems in the PA type group will 
be collected for the CPU collection. 

Data Table Matrix 

Table/File

Raw Table 

Rate Table 

Property Table 

Teel File 

Property Table Matrix 

 Name 

xSR_OVPA_CPU 

RSR_OVPA_CPU 

K_OVPA_CPU 

SysResOVPA_CPU.teel 

Table/File Name 

Property Table K_OVPA_CPU 

Teel File prop_OVPA_CPU.teel 

History Property Table Matrix 

Table/File

Property Table 

History Property Table 

History Teel File 

 Name 

K_OVPA_CPU_History 

K_OVPA_CPU_History 

prop_OVPA_CPU_history.teel 
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Collected CPU Metrics 

The collection table is RSR_OVPA_CPU. Supported metrics vary from platform to platform 
and from PA to EPC agents. 

Metric Description 

BYCPU_ID CPU ID 

BYCPU_CPU_SYS_MODE_UTIL The percent of time CPU was in System Mode. 

BYCPU_CPU_USER_MODE_UTIL The percent of time CPU was in User Mode. 

BYCPU_CPU_TOTAL_UTIL The percent CPU utilization. 

BYCPU_STATE CPU State 

BYCPU_INTERRUPT_RATE Average number of device interrupts. 

BYCPU_CSWITCH_RATE Context switch rate 

Daily Processing 

The SR_Daily_CPU.pro file is invoked at 2:00 every morning. The daily processing consists of 
running the SD_SR_CPU.sum file. 

Hourly Processing 

The SR_Hourly_CPU.pro file is invoked every hour. 

The hourly processing handles new systems, updates the CPU property table, and data 
mapping from the datapipe rate table to the System Resource CPU Report Pack base table. 

When new systems are found they need to be added to K_Node before the summaries take 
place. This is done using the stored procedure ppSR_OVPACPU_SetIDs. The stored procedure 
is invoked using the SQL script execute_SR_OVPACPU_SetIDs.sql. The stored procedure 
populates K_Node with the new system and populates the node_fk column in the datapipe 
property table with the dsi_key_id value for that system from K_Node. 

The CPU update populates the K_System_CPU property table with the CPU state. 
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Mapping RSR_OVPA_CPU to SH_SR_CPU 

Purpose: Map system metrics from RSR_OVPA_CPU to the System Resource CPU base table 
SH_SR_CPU. 

File: SH_SR_CPU.sum 
source table: RSR_OVPA_CPU 
destination table: SH_SR_CPU 
by variable: node_fk 
by variable: CPUid 
by variable: hour 

column: CPUSystemMode=BYCPU_CPU_SYS_MODE_UTIL:avg 
column: CPUUserMode=BYCPU_CPU_USER_MODE_UTIL:avg 
column: CPUUtil=BYCPU_CPU_TOTAL_UTIL:avg 
column: CSRate=BYCPU_CSWITCH_RATE:avg 
column: IntRate=BYCPU_INTERRUPT_RATE:avg 

Source Metric Destination Metric Summary Type 

BYCPU_CPU_SYS_MODE_UTIL AVGCPUSystemMode avg 

BYCPU_CPU_USER_MODE_UTIL AVGCPUUserMode avg 

BYCPU_CPU_TOTAL_UTIL AVGCPUUtil avg 

BYCPU_CSWITCH_RATE AVGCSRate avg 

BYCPU_INTERRUPT_RATE AVGIntRate avg 

2. Logical Volume Sub-Package 

The Logical Volume sub-package collects data from the Logical Volume class. All systems in 
the PA type group are collected for the Logical Volume collection. 

Data Table Matrix 

Table/File

Raw Table 

Rate Table 

Property Table 

Teel File 

 Name 

xSR_OVPA_LV 

RSR_OVPA_LV 

K_OVPA_LogicalVolue 

SysResOVPA_LogicalVolume.teel 
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Property Table Matrix 

Table/File Name 

Property Table K_OVPA_LogicalVolume 

Teel File prop_OVPA_LogicalVolume.teel 

History Property Table Matrix 

Table/File

Property Table 

History Property Table 

History Teel File 

 Name 

K_OVPA_LV_History 

K_OVPA_LV_History 

prop_SysResOVPA_LV_history.teel 

Collected Logical Volume Metrics 

The collection table is RSR_OVPA_LogicalVolume. Supported metrics vary from platform to 
platform and are supported on the PA agent only. 

Metric Description 

LV_DIRNAME The absolute path name of Logical volume on HP OS. 

LV_READ_RATE Number of physical reads per second for this logical 
volume during the interval. 

LV_WRITE_RATE Number of physical writes per second for this logical 
volume during the interval. 

LV_SPACE_UTIL Percent of the logical volume file system space in use 
during the interval. 

Daily Processing 

The SR_Daily_LogicalVolume.pro file is invoked at 2:00 every morning. The daily processing 
consists of running the SD_SR_LogicalVolume.sum file. 

Hourly Processing 

The SR_Hourly_LogicalVolume.pro file is invoked every hour. 

The hourly processing handles new systems and data mapping from the datapipe rate table to 
the System Resource Logical Volume Report Pack base table. 

When new systems are found, they need to be added to K_Node before the summaries take 
place. This is done using the stored procedure ppSR_OVPALogicalVolume_SetIDs. The stored 
procedure is invoked using the SQL script execute_SR_OVPALogicalVolume_SetIDs.sql. The 
stored procedure populates K_Node with the new system and populates the node_fk column in 
the datapipe property table with the dsi_key_id value for that system from K_Node. 
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Mapping RSR_OVPA_LogicalVolume to SH_SR_LogicalVolume 

Purpose: Map metrics from RSR_OVPA_LogicalVolume to the LogicalVolume base table 
SH_SR_LogicalVolume. 

File: SH_SR_LogicalVolume.sum 
source table: RSRV_OVPA_LogicalVolume 
destination table: SH_SR_LogicalVolume 
by variable: node_fk 
by variable: LV_DIRNAME 
by variable: hour 

Source Metric Destination Metric Summary Type 

LV_READ_RATE AVGReadRate avg 

LV_WRITE_RATE AVGWriteRate avg 

LV_SPACE_UTIL AVGSpaceUtil avg 

3. Network Interface Sub-Package 

The Network Interface sub-package collects data from the Network Interface class. All 
systems in the PA type group will be collected for the Network Interface collection. 

Data Table Matrix 

Table/File

Raw Table 

Rate Table 

Property Table 

Teel File 

Property Table Matrix 

 Name 

xSR_OVPA_NetIf 

RSR_OVPA_NetIf 

K_OVPA_NetInterface 

SysResOVPA_NetInterface.teel 

Table/File Name 

Property Table K_OVPA_NetInterface 

Teel File prop_OVPA_NetInterface.teel 
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History Property Table Matrix 

Table/File

Property Table 

History Property Table 

History Teel File 

 Name 

K_OVPA_NetInterface_History 

K_OVPA_NETIF_History 

prop_SysResOVPA_NetIf_history.teel 

Collected Network Interface Metrics 

The collection table is RSR_OVPA_NetIf. Supported metrics vary from platform to platform 
and from PA to EPC agents. 

Metric Description 

BYNETIF_COLLISION_RATE The name of the network interface. 

BYNETIF_IN_PACKET_RATE The number of physical collisions per second on 
the network interface during the interval. 

BYNETIF_OUT_PACKET_RATE The number of successful physical packets per 
second received through the network interface 
during the interval. 

BYNETIF_IN_BYTE_RATE The number of successful physical packets per 
second sent through the network interface during 
the interval. 

BYNETIF_OUT_BYTE_RATE The number of KBs per second received to the 
network via this interface during the interval. 

BYNETIF_ERROR_RATE Number of KBs per second sent to the network 
via this interface during the interval. 

BYNETIF_NET_SPEED Number of physical errors per second on the 
network interface during the interval. 

BYNETIF_COLLISION_RATE The speed of this interface. 

Daily Processing 

The SR_Daily_NetInterface.pro file is invoked at 2:00 every morning. The daily processing 
consists of running the SD_SR_NetInterface.sum file. 

Hourly Processing 

The SR_Hourly_NetInterface.pro file is invoked every hour. 

The hourly processing handles new systems and data mapping from the datapipe rate table to 
the System Resource Network Interface Report Pack base table. 
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When new systems are found, they need to be added to K_Node before the summaries take 
place. This is done using the stored procedure ppSR_OVPANetIf_SetIDs. The stored 
procedure is invoked using the SQL script execute_SR_OVPANetIf_SetIDs.sql. The stored 
procedure populates K_Node with the new system and populates the node_fk column in the 
datapipe property table with the dsi_key_id value for that system from K_Node. 

Mapping RSR_OVPA_NetIf to SH_SR_NetInterface 

Purpose: Map system metrics from RSR_OVPA_NetIf to the Network Interface base table 
SH_SR_NetInterface. 

File: SH_SR_NetInterface.sum 
source table: RSR_OVPA_NetIf 
destination table: SH_SR_NetInterface 
by variable: node_fk 
by variable: prop_netif_name 
by variable: hour 

column: CollisionRate=BYNETIF_COLLISION_RATE:avg 
column: InPackets=BYNETIF_IN_PACKET_RATE:avg 
column: OutPackets=BYNETIF_OUT_PACKET_RATE:avg 
column: InBytes=BYNETIF_IN_BYTE_RATE:avg 
column: OutBytes=BYNETIF_OUT_BYTE_RATE:avg 
column: ErrorRate=BYNETIF_ERROR_RATE:avg 
column: NetSpeed=BYNETIF_NET_SPEED:avg 

Source Metric Destination Metric Summary Type 

BYNETIF_COLLISION_RATE AVGCollisionRate avg 

BYNETIF_IN_PACKET_RATE AVGInPackets avg 

BYNETIF_OUT_PACKET_RATE AVGOutPackets avg 

BYNETIF_IN_BYTE_RATE AVGInBytes avg 

BYNETIF_OUT_BYTE_RATE AVGOutBytes avg 

BYNETIF_ERROR_RATE AVGErrorRate avg 

BYNETIF_NET_SPEED AVGNetSpeed avg 
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4. Disk Sub-Package 

The Disk sub-package collects data from the Disk class. All systems in the PA type group will 
be collected for the Disk collection. 

Data Table Matrix. 

Table/File

Raw Table 

Rate Table 

Property Table 

Teel File 

Property Table Matrix 

 Name 

xSR_OVPA_Disk 

RSR_OVPA_Disk 

K_OVPA_Disk 

SysResOVPA_Disk.teel 

Table/File Name 

Property Table K_OVPA_Disk 

Teel File prop_OVPA_Disk.teel 

History Property Table Matrix 

Table/File

Property Table 

History Property Table 

History Teel File 

 Name 

K_OVPA_Disk 

K_OVPA_DISK_History 

prop_SysResOVPA_Disk_history.teel 

Collected Disk Metrics 

The collection table is RSR_OVPA_Disk. Supported metrics vary from platform to platform 
and from PA to EPC agents. 

Metric Description 

BYDSK_DEVNAME Name identifying the specific disk. 

BYDSK_DIRNAME Name of the file system directory mounted on this 
disk device. Displays Multiple FS if more than 
one exists. 

BYDSK_AVG_SERVICE_TIME Average time, in milliseconds, that this disk spent 
in processing each disk request during the 
interval 

BYDSK_PHYS_IO_RATE Average number of physical IO requests per 
second for this disk device during the interval. 
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Metric Description 

BYDSK_UTIL Utilization, or percent of the time busy servicing 
requests for this device. 

BYDSK_FS_READ_RATE Number of physical file system reads per second 
from this disk device during the interval. 

BYDSK_FS_WRITE_RATE Number of physical file system writes per second 
from this disk device during the interval. 

BYDSK_VM_IO_RATE Number of virtual memory IOs per second to this 
disk device during the interval. 

BYDSK_RAW_READ_RATE Number of raw reads per second from this disk 
device during the interval. 

BYDSK_RAW_WRITE_RATE Number of raw writes per second to this disk 
device during the interval. 

BYDSK_SYSTEM_IO_RATE Number of physical system reads or writes per 
second to this disk device during the interval. 

Daily Processing 

The SR_Daily_Disk.pro file is invoked at 2:00 every morning. The daily processing consists of 
running the SD_SR_Disk.sum file. 

Hourly Processing 

The SR_Hourly_Disk.pro file is invoked every hour. Hourly processing handles new systems 
and data mapping from the datapipe rate table to the Disk Sub-Package base table. 

When new systems are found, they need to be added to K_Node before the summaries take 
place. This is done using the stored procedure ppSR_OVPADisk_SetIDs. The stored procedure 
is invoked using the SQL script execute_SR_OVPADisk_SetIDs.sql. The stored procedure 
populates K_Node with the new system and populates the node_fk column in the datapipe 
property table with the dsi_key_id value for that system from K_Node. 
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Mapping RSR_OVPA_Disk to SH_SR_Disk 

Purpose: Map metrics from RSR_OVPA_Disk to the SH_SR_Disk base table. 

File: SH_SR_Disk.sum 
source table: RSR_OVPA_Disk 
destination table: SH_SR_Disk 
by variable: node_fk 
by variable: prop_disk_name 
by variable: hour 

column: ServiceTime=BYDSK_AVG_SERVICE_TIME:avg 
column: DiskUtil=BYDSK_UTIL:avg 
column: PhysicalIORate=BYDSK_PHYS_IO_RATE:avg 
column: FSReadRate=BYDSK_FS_READ_RATE:avg 
column: FSWriteRate=BYDSK_FS_WRITE_RATE:avg 
column: RawReadRate=BYDSK_RAW_READ_RATE:avg 
column: RawWriteRate=BYDSK_RAW_WRITE_RATE:avg 
column: c=BYDSK_VM_IO_RATE:avg 
column: SystemIORate=BYDSK_SYSTEM_IO_RATE:avg 

Source Metric Destination Metric Summary Type 

BYDSK_AVG_SERVICE_TIME AVGServiceTime avg 

BYDSK_UTIL AVGDiskUtil avg 

BYDSK_PHYS_IO_RATE AVGPhysicalIORate avg 

BYDSK_FS_READ_RATE AVGFSReadRate avg 

BYDSK_FS_WRITE_RATE AVG FSWriteRate avg 

BYDSK_RAW_READ_RATE AVGRawReadRate avg 

BYDSK_RAW_WRITE_RATE AVGRawWriteRate avg 

BYDSK_VM_IO_RATE AVGVMIORate avg 

BYDSK_SYSTEM_IO_RATE AVGSystemIORate avg 
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The SystemResourceDiskDetails.rep file for System Resource report pack 4.40 does not 
work when PI 5.30 and later is using a Sybase database. PI, in this case, generates empty 
Details table and graphs. 
The problem occurs because of the following incorrectly capitalized column names in the 
SystemResourceDiskDetails.rep file: 
• AVGDiskUtil_Formatted 
• AVGPHYSReadRate 
• AVGPHYSWriteRate 
We strongly recommend you to test each report on both Sybase and Oracle systems every 

time you create or update it.

To solve this problem, 

1 Download the UPGRADE_SR_CPU_to_43.ap.tar hotfix. 


Note that the hotfix is available only for PI version 5.30 and later. 

2 Copy the hotfix to {DPIPE_HOME}/packages/SystemResource directory. 
3 Extract the UPGRADE_SR_DISK_to_45.ap file from the TAR file. 
4 Run the Package Manager utility to install the UPGRADE_SR_DISK_to_45.ap. 
Note that this hotfix works on all operating systems supported by PI. 
40 Chapter 4 

http:UPGRADE_SR_DISK_to_45.ap


5. Process Sub-Package 

The Process sub-package performs an hourly collection. The Process collection collects all 
systems in the PA type group. 

Data Table Matrix. 

Table/File

Raw Table 

Rate Table 

Property Table 

Teel File 

Property Table Matrix 

 Name 

xSR_OVPA_process 

RSR_OVPA_process 

K_ProcOVPA_proc 

SysResOVPA_Process.teel 

Table/File Name 

Property Table K_ProcOVPA_proc 

Teel File prop_ProcOVPA_proc.teel 

History Property Table Matrix 

Table/File

Property Table 

History Property Table 

History Teel File 

 Name 

K_OVPA_proc 

K_OVPA_PROC_HISTORY 

prop_ProcOVPA_proc_history.teel 

Collected Process Metrics 

The collection table is RSR_OVPA_process. Supported metrics vary from platform to platform 
and are only supported by the PA agent. 

Metric 

PROC_CPU_TOTAL_TIME 

PROC_PROC_NAME 

PROC_CPU_TOTAL_UTIL 

PROC_THREAD_COUNT 

PROC_MEM_VIRT 

Description 

Total CPU Time consumed in seconds. 

Process name. 

Percentage of CPU Time Consumed. 

Total number of threads. 

Sum of virtual memory used. 
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Daily Processing 

The SR_Daily_Process.pro file is invoked at 2:00 every morning. The daily processing consists 
of running the SD_SR_proc.sum file. 

Hourly Processing 

The SR_Hourly_Process.pro file is invoked every hour. 

The hourly processing handles new systems and data mapping from the datapipe rate table to 
the System Resource Disk Report Pack base table. 

When new systems are found, they need to be added to K_Node before the summaries take 
place. This is done using the stored procedure ppSR_OVPAProc_SetIDs. The stored procedure 
is invoked using the SQL script execute_SR_OVPAProc_SetIDs.sql. The stored procedure 
populates K_Node with the new system and populates the node_fk column in the datapipe 
property table with the dsi_key_id value for that system from K_Node. 

Mapping RSR_OVPA_process to SH_SR_Process 

Purpose: Maps metrics from RSR_OVPA_process to the SH_SR_Process base table. 

File: SH_SR_proc.sum 
source table: xSR_OVPA_process 
destination table: SH_SR_Process 
by variable: node_fk 
by variable: Process_Name 
by variable: hour 

column: CPUTime=PROC_CPU_TOTAL_TIME:tot 
column: CPUUtil=PROC_CPU_TOTAL_UTIL:avg 
column: ThreadCount=PROC_THREAD_COUNT:tot 
column: VirtualMem=PROC_MEM_VIRT:tot 

Source Metric Destination Metric Summary Type 

PROC_CPU_TOTAL_TIME TOTCPUTime tot 

PROC_CPU_TOTAL_UTIL AVGCPUUtil avg 

PROC_THREAD_COUNT TOTThreadCount tot 

PROC_MEM_VIRT TOTVirtualMem tot 
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6. Logical System Sub-Package 

The Logical System sub-package performs an hourly summary, a daily summary, and a 
monthly summary. The Logical System collection collects all systems in the PA type group. 

Data Table Matrix. 

Table/File

Raw Table 

Rate Table 

Property Table 

Teel File 

Property Table Matrix 

 Name 

xSR_OVPA_LS 

RSR_OVPA_LS 

K_OVPA_LS 

SysResOVPA_LS.teel 

Table/File Name 

Property Table K_OVPA_LS 

Teel File prop_OVPA_LS.teel 

History Property Table Matrix 

Table/File

Property Table 

History Property Table 

History Teel File 

 Name 

K_OVPA_LS_HISTORY 

K_OVPA_LS_HISTORY 

prop_OVPA_LS_history.teel 

Collected Metrics 

The SR_LS module collects virtualization metrics from OVPA 4.60. The metrics collected by 
OVPA 4.60 are coming from HPVM, or AIX LPARS, or both. 

Daily Processing 

The SR_Daily_LS.pro file is invoked at 2:00 a.m. every morning. The daily processing consists 
of running the SD_SR_LS.sum and SM_SR_LS.sum. 

Hourly Processing 

The SR_Hourly_LS.pro file is invoked every hour. 

The hourly processing handles new systems, updates the Logical System property table, and 
maps data from the datapipe rate table to the System Resource Logical System Report Pack 
base table. 
Data Collection 43 



When new systems are found, they need to be added to K_Node before the summaries take 
place. This is done using the stored procedure ppSR_OVPALS_SetIDs. The stored procedure 
populates K_node with the new system and populates the node_fk column in the datapipe 
property table with the dsi_key_id value for that system from K_Node. The 
update_K_System_LS.sql populates the K_System_LS property table with the Logical System 
state. 

The Hourly processing consists of running SH_SR_LS.sum and SH_SR_LS_byHost.sum. 

Mapping RSR_OVPA_LS to SH_SR_LS 

Purpose: Map system metrics from RSR_OVPA_LS to SH_SR_LS base table. 

File: SH_SR_LS.sum File: SH_SR_LS_byHost.sum 
source table: xSR_OVPA_LS source table: xSR_OVPA_LS 
destination table: SH_SR_LS destination table: SH_SR_LS 
by variable: dsi_target_name by variable: dsi_target_name 
by variable: dsi_table_key by variable: hour 
by variable: hour 

column: UP=(case when ((BYLS_LS_STATE like “on”) or (BYLS_LS_STATE like “Up”)) 
then 1 else 0 end):cnt,lst 
column: !NUM_CPU=BYLS_NUM_CPU:wav 
column: !NUM_DISK=BYLS_NUM_DISK:wav 
column: !NUM_NETIF=BYLS_NUM_NETIF:wav 
column: !CPU_Entl=BYLS_CPU_ENTL_MAX:wav 
column: UpTime=case when (INTERVAL>delta_time) then delta_time else INTERVAL 
end:tot 
column: !LSResourceMode=BYLS_LS_MODE:lst 

column: !SysUpTime=BYLS_UPTIME_SECONDS:lst 
column: PhysCPUTime=BYLS_CPU_PHYS_TOTAL_TIME:tot 
column: PhysCPUUtil=BYLS_CPU_PHYS_TOTAL_UTIL:min,avg,max 
column: LSCPUTotalUtil=BYLS_CPU_TOTAL_UTIL:avg 
column: PhysMemUsed=BYLS_MEM_ENTL:min,avg,max 
column: LSMemEntilUtil=BYLS_MEM_ENTL_UTIL:min,avg,max 
column: !Mem_Entl=(case when (BYLS_MEM_ENTL_MAX is not null) then 
BYLS_MEM_ENTL_MAX else BYLS_MEM_ENTL end):wav 
column: LSRunQue=BYLS_RUN_QUEUE:avg 

Source Metric Destination Metric Summary Type 

BYLS_LS_STATE CNTUP cnt 

BYLS_LS_STATE  LSTUP lst 

BYLS_NUM_CPU  NUM_CPU wav 

BYLS_NUM_DISK NUM_DISK wav 

BYLS_NUM_NETIF NUM_NETIF wav 
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BYLS_CPU_ENTL_MAX CPU_Entl wav 

INTERVAL UpTime case when 
(INTERVAL>delta_time) 
then delta_time else 
INTERVAL end 

tot 

BYLS_UPTIME_SECONDS SysUpTime lst 

BYLS_CPU_PHYS_TOTAL_UTIL MINPhysCPUUtil min 

BYLS_CPU_PHYS_TOTAL_UTIL AVGPhysCPUUtil avg 

BYLS_CPU_PHYS_TOTAL_UTIL MAXPhysCPUUtil max 

BYLS_CPU_TOTAL_UTIL AVGLSCPUTotalUtil avg 

BYLS_MEM_ENTL MINPhysMemUsed min 

BYLS_MEM_ENTL MAXPhysMemUsed max 

BYLS_MEM_ENTL AVGPhysMemUsed avg 

BYLS_MEM_ENTL_UTIL MINLSMemEntilUtil min 

BYLS_MEM_ENTL_UTIL MAXLSMemEntilUtil max 

BYLS_MEM_ENTL_UTIL AVGLSMemEntilUtil avg 

BYLS_MEM_ENTL Mem_Entl wav 

BYLS_RUN_QUEUE AVGLSRunQue avg 

BYLS_LS_MODE LSResourceMode lst 
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5 Setting Up a Distributed System

These are the steps to follow when setting up a distributed system: 

•	 Decide whether or not you want local reporting 

•	 Install the right set of packages on each server (a central server that is not polling will not 
need datapipes; the satellite servers will need datapipes) 

•	 Verify that the system clocks in your environment are synchronized 

•	 Register your satellite servers 

•	 If you are not copying rate data to the central server, enable LIR on the central server 

•	 If you enable LIR, add LIR mapping with the time type set to rate 

•	 Verify that you have all the copy policies you need 

•	 Configure the central server (manual edits to trendtimer.sched and .pro files) 

•	 Configure each satellite server (manual edits to trendtimer.sched and .pro files) 

If you want to set up a distributed system, you can implement local reporting or you can 
implement centralized reporting. If you want local reporting, you need to deploy reports when 
you install the report pack on each satellite server, and you need to allow summarizations to 
run on each satellite server. If you do not want local reporting, then you do not need to deploy 
reports when you install a report pack on a satellite server and you can disable the scripts 
that run summarizations on each satellite server. 

Before Location Independent Reporting (LIR) was available, our recommendation to anyone 
setting up a distributed system was to deploy reports on satellite servers, keep rate data on 
satellite servers, copy hourly data to the central server, and disable summarizations above the 
hourly level on satellite servers. The advantage to this approach was that it kept a large 
volume of rate data off the network and it decreased the processing load on the central server. 
The disadvantage is that the central server could not display a Near Real Time (NRT) report. 
The only NRT report was a local NRT report, on a satellite server. LIR overcomes this 
disadvantage. With LIR, now you can open an NRT report on the central server and 
drill-down on any selection you make. The selection you make prompts the central server to 
query a satellite server for locally aggregated data. Of course, if you would rather copy rate 
data to the central server, you can. If you do that, then enabling LIR is not necessary. 

System Resource includes a copy policy import file. When you install System Resource, the 
core product uses the copy policy import file to generate copy policies. As a result, you do not 
need to create copy policies yourself using the Management Console. Instead, your only task 
related to copy policies is to verify that the copy policies you need already exist. 

Because you are likely to have multiple satellite servers, we designed the trendtimer.sched 
file and the .pro files to accommodate satellite server requirements. This means that most of 
the time most of the defaults are correct. But some defaults will be incorrect, or less than 
optimal, and to improve performance you should change them. These manual edits, as well as 
the other steps listed above, are spelled out in detail below. 
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Installing System Resource on Multiple Servers 

If you intend to run System Resource as a distributed system across multiple servers, each 
server must be configured. Before configuring the servers, verify that everything is installed 
where it needs to be installed. As shown in the following table, the datapipes belong on the 
satellite servers, otherwise package installation is the same across all servers. 

Central Server 

System Resource 4.50 
SystemResource_Thresholds 3.20 
Thresholds Module 5.10 
Common Property Tables 3.90 

Satellite Server 

System Resource 4.50 
SystemResource_Thresholds 3.20 
Thresholds Module 5.10 
Common Property Tables 3.90 
SysRes RFC1514 Datapipe 4.10 
SR OVPA Datapipe 3.30 
OVPA Collection Datapipe 1.00 

If you do not need local reporting, do not deploy reports when you install the report pack on a 
satellite server. If you want to view reports locally, deploy reports. 

Where you install the optional thresholds sub-package depends on how you want thresholding 
to work. If you want to set thresholds on hourly data, install the thresholds sub-package on 
satellite servers. If you want to set thresholds on aggregated data, install the thresholds 
sub-package on the central server. 

If you intend to collect System Resource / PA type group data in a distributed environment, 
disable execute_SR_OVPA_SetOVPAType.sql in all servers. This process automatically 
populates type groups in the collection process. However, for a distributed environment, it is 
better to have manual control over the type groups so as to avoid duplicate polling. 

Central Server Configuration 

To configure the central server, perform the following tasks: 

• Task 1: Register the satellite server by setting the database role 

• Task 2: Enable LIR 

• Task 3: Add LIR mappings 

• Task 4: Verify the automatically generated copy policies 

• Task 5: Delete LIR mappings for rate tables 

• Task 6: Modify the SR_Hourly_Reporting.pro file 

Task 1: Register the satellite server by setting the database role 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Systems icon in the navigation pane. 

3 Navigate to the PI Databases folder and select the database system. 
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4 Click Database Properties. 

5 From the Database Role list, select the Satellite Server role. 

6 Enter any information necessary to configure the Satellite Server role. 

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application. 

Task 2: If you are not copying rate data to the central server, enable LIR. 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Systems icon in the navigation pane. 

3 Navigate to the PI Databases folder and select the central server. 

4 Click LIR Configuration. 

5 Select the LIR enabled check box. 

Task 3: If you enable LIR, add LIR mappings. 

1 Start the Management Console (log on with Administrator privileges).


2 Click the Systems icon in the navigation pane.


3 Navigate to the PI Databases folder and select the central server.


4 Click LIR Configuration. 

5 Click Add Mapping. 

6 From the Select Satellite Server list, select a satellite server to which to add a mapping. 

7 Select the Category data table option. 

8 Select System Resource from the drop down list. 

9 Select the rate data type. 

10 Click Add to List. 

11 Repeat steps 8 through 10 for each SR sub-package: 

• Logical System 

• Logical Volume 

• Process 

• Network Interface 

• CPU 

• Disk 

12 If you have more than one satellite server, click Add Mapping and repeat step 6 through 
step 10 for each server. 

13 Click OK. 

14 Click Apply. 

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 9 above) determines 
the type of data copied (defined in the generated copy policy). The type of data copied (defined 
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in the generated copy policy) is one summarization level greater than the data type selected in 
the LIR mapping. For example, if you select an hourly data type, you will generate a daily 
data copy policy. 

Task 4: Verify the automatically generated copy policies 

Verify that a copy policy has been generated for the following tables and that the copy type is 
set correctly (to Property and Data): 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager. 

3 Find the following tables and verify the copy type is set to Property and Data: 

SystemResource.ap 

• SH_SR_SysXcep 

• SH_SR_SysVolXcep 

• SH_SR_SysUp 

• SH_AppOVPA_SysApp 

• SRTran_Transaction 

• SR_SR_FileSystem 

• SR_SR_Kernel 

SysRes OVPA CPU 

• SH_SR_CPU 

SysRes OVPA Disk 

• SH_SR_Disk 

SysRes OVPA Logical Volume 

• SH_SR_Logicalvolume 

SysRes OVPA Logical System 

• SH_SR_LS 

SysRes OVPA Net Interface 

• SH_SR_Netinterface 

SysRes OVPA Process 

• SH_SR_Process 

If a copy policy has not been generated for a table, do the following: 

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy 
Manager. The Copy Policy Wizard displays. 

2 Click Next. The Satellite Server and Copy Policy Selection Page displays. 

3 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server. 

4 Select Single Table and select the table from the pull down list. 

5 Click Next. The Copy Type Selection Page displays. 

6 Select Property and Data. 
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7 Click Next. The Summary page displays. 

8 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back. 

9 Click Finish. 

10 Repeat step 4 - step 9 for all missing tables.


If the copy type is not set to Property and Data, do the following:


1 Double-click the copy policy. 

2 Select the Property and Data copy type. 

3 Click OK. 

Task 5: Delete LIR Mappings for Rate Tables 

Delete the LIR mappings for SRTran_Transaction, SR_SR_FileSystem and SR_SR_Kernel 

(the data is being copied to the central server).


1 Start the Management Console (log on with Administrator privileges).


2 Click the Systems icon in the navigation pane.


3 Navigate to the PI Databases folder and select the central server.


4 Click LIR Configuration. 

5 Unselect the Rate check box for K_SR_FileSystem and K_SR_System. 

6 Click Apply. 

Task 6: Modify the following six process files: 

• SR_Hourly_Reporting.pro file 

• SR_Hourly_CPU.pro 

• SR_Hourly_Disk.pro 

• SR_Hourly_Logicalvolume.pro 

• SR_Hourly_Netinterface.pro 

• SR_Hourly_volume.pro


All six process files are found here:


{DPIPE_HOME}/scripts/


where {DPIPE_HOME} is the directory in which PI is installed.


In each file, find and comment out the following lines:


begin:block 1 wait


end:


Satellite Server Configuration 

Follow these steps to configure each satellite server. 

1 Modify the trendtimer.sched file. 
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The trendtimer.sched file is found in the {DPIPE_HOME}/lib/ directory where 
{DPIPE_HOME} is the directory in which PI is installed. 

Make the following changes: 

•	 Find and comment out the following line: 

24:00+2:00 - - {DPIPE_HOME}/bin/trend_proc -f
{DPIPE_HOME}/scripts/SR_Server_Reporting.pro 

•	 Find and change the following line (modify the daily processing time): 

1:00+40 - - {DPIPE_HOME}/bin/trend_proc -f
{DPIPE_HOME}/scripts/SR_Hourly_Reporting.pro 

to 

1:00+25 - - {DPIPE_HOME}/bin/trend_proc -f 
{DPIPE_HOME}/scripts/SR_Hourly_Reporting.pro 

2	 Modify the following process files: 

•	 SR_Hourly_Reporting.pro file 

•	 SR_Hourly_CPU.pro 

•	 SR_Hourly_Disk.pro 

•	 SR_Hourly_Logicalvolume.pro 

•	 SR_Hourly_Netinterface.pro 

• SR_Hourly_volume.pro


The files are located here:


{DPIPE_HOME}/scripts/


where {DPIPE_HOME} is the directory in which PI is installed.


Make the following changes:


•	 Find and comment out the following lines: 

begin:block2 wait 

end:block2 

•	 Find and uncomment the following lines: 

begin:block3 wait 

end:block3 

3	 Configure datapipe polling policies, making sure that each system is polled by one 
satellite server only. 

4 If the satellite server has two or more pollers, create separate polling policies for each 
poller and use views and types to separate the devices. 

5 If remote pollers are being used, be sure to avoid duplicate polling across the pollers and 
duplicate polling between the satellite and the pollers. 
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System Clocks 

Make sure the system clock on each satellite server is synchronized with the system clock on 
the central server. 
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6 Thresholds and Change Forms

This chapter covers the following topics: 

• Default thresholds set by the thresholds sub-package 

• Using change forms to: 

— Update system properties (multiple thresholds to set) 

— Update filesystem properties (one threshold to set) 

— Update logical system properties (muliple thresholds to set) 

When you modify the default settings in a property form, you modify a thresholds policy. 
Changes to the Update System Properties form or the Update FileSystem Properties form 
update the SystemResource_Thresholds subpackage, while changes to the Logical System 
Properties form update the SR_LS_Thresholds subpackage. 

Default Settings for Thresholds 

The thresholds sub-package imposes a sets of thresholds for systems and filesystems. When 
performance reaches a default, PI sends a trap to the network management system. The 
following table indicates the threshold and severity level. 

Metric Default Threshold Severity 

cpuutil_threshold 80% MEDIUM 

swaputil_threshold 70% MEDIUM 

memutil_threshold 70% MEDIUM 

runq_threshold 3 MEDIUM 

pageout_threshold 5 MEDIUM 

FSutil_threshold 70% MEDIUM 

The first 5 threshold values are defined in the K_SR_System.teel file. The last threshold 
value is defined in the K_SR_FileSystem.teel file. Every system that is discovered will be 
initialized to the default values shown here. 

No intervention on your part is required to implement these defaults. Simply install the 
thresholds sub-package. If you want to change one or more default settings, use the change 
forms described later in this chapter. If you want to modify the action that PI takes in 
response to an exception condition, configure the Thresholds Module. For details, see the 
Thresholds Module 5.10 User Guide. 
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Using Change Forms to Update Properties 

Using forms, you can modify the system, filesystem, and logical system objects maintained for 
System Resource. These forms do not allow you to create new objects, only to modify existing 
objects. The forms are context-sensitive, which means they will modify every object that you 
selected before you launched the form. So be sure to use forms carefully. Know in advance 
whether you intend to change one object or multiple objects. 

To create new nodes, locations or customers, or modify existing nodes, locations, or customers, 
use the forms in Common Property Tables. 

To launch any form, click the Objects icon in the panel on the left side of the Management 
Console window. The Object/Property Management view opens. Object Manager will present a 
list of objects. The type of object presented depends on which Object Manager View is open. 

The default view is the Device view, showing a list of devices. The Customer view shows a list 
of customers, and the Location view shows a list of locations. To change the view, select View > 
Change View and use the pop-up window to select a different view. 

Once the type of object you are interested in updating appears, select the particular object you 
would like to update. When you select the object, the name of the property form will appear 
under Object Specific Tasks. To open the form, double-click. 

Update System Properties 

To update system information, type the changes in the fields provided. Note that the customer 
name field and the location name field are disabled. The other fields can be modified. To save 
your changes, click Apply. When you finish making changes, click OK to save your changes and 
close the form. 
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Update Filesystem Properties 

To update filesystem properties, type the changes in the fields provided. The customer name 
field and the location name field are disabled. The other fields can be modified. To save your 
changes, click Apply. When you finish making changes, click OK to save your changes and close 
the form. 
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Logical System Properties 

Use the LS Properties form to modify thresholds limits for: 

• Physical CPU % 

• Logical CPU % 

• Entitled Memory 

• Run Queue 

Default thresholds cannot be updated globally. The changes you make must be made on a 
node-by-node basis. If you are collecting data from HPVM, ignore values the following 
defaults: 
• Entitled Memory 
• Run Queue 
These defaults do not apply to HPVM. No matter what value is in these fields, no threshold 
breech will be triggered. 
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7 Optimizing Resources 

Filesystems Resource Optimization brings into focus the most overutilized and the most 
underutilized filesystems. Use this report to see where load balancing, as opposed to investing 
in additional resources, might be the easiest way to improve service quality. 

The selection table at the top of the report provides a list of systems that are expected to reach 
90% utilization within 90 days. The grade of service bar chart beneath the selection table 
provides a picture of utilization over the last few days, allowing you to track recent increases 
and decreases and determine whether a critical situation is getting better or worse. The plot 
beneath the grade of service chart tracks daily ups and downs in utilization (CPU, memory, 
swap, filesystem, page outs, and run queue length). 

Information about underutilized filesystems comes next. This time the selection table 
includes filesystems that are expected to be less than 30% utilized within 90 days. 

Memory Resource Optimization pinpoints the most overutilized and underutilized system 
memory, indicating opportunities where service levels could be improved through better load 
balancing. Select a system from the top table to display detailed information for that system. 

All aggregation for this report occurs at the daily level. The top selection table lets you see 
which systems will have a memory utilization greater than 90% in 90 days. You can also see 
an estimate for memory utilization 30, 60 and 90 days from now. The table directly below the 
top selection table provides provisioning details for the selected system: 

• Customer 

• Location 

• Vendor 

• Model 

• Operating system 

• Memory utilization threshold 

A grade of service stacking bar chart details the overall health of the system, including CPU 
utilization, memory utilization, swap utilization and run queue length. A linked, tabbed plot 
pinpoints daily CPU utilization, memory utilization, swap utilization, filesystem utilization, 
number of page outs, and run queue length for the selected system. The top selection table 
and linked drill downs are repeated for systems that are projected to have less than 30% 
memory utilization in 90 days. 
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8 Service Level Management

The Service Level Management - Executive Summary looks at yesterday’s Grade of 
Service and yesterday’s exception counts. This report analyzes performance data for multiple 
systems, aggregated by customer and location, hence the term summary. 

Use the SLM report to verify whether service quality is meeting expectations. The top 
selection table provides a list of customers ranked by number of exceptions, highest to lowest. 
The data for each customer provides exceptions statistics all of the systems owned by that 
customer. The second selection table provides a list of locations ranked by number of 
exceptions, highest to lowest. The location selection table is linked to the top selection table, 
and separates out the total exceptions for each location. 

This report allows you to drill down from information about yesterday’s distribution of 
exceptions to a stacked bar chart showing hourly, daily, and monthly views of exceptions and 
how they are distributed. The stacked bar chart shows total exceptions for all systems at the 
location selected above. At the end of the report, a grade of service chart provides an hourly 
assessment of health. This chart is aggregating data from all of the systems at the location 
highlighted in the location table. 
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9 Resource Forecasting 

You have two reports in the resource forecasting area: 

• Filesystem Forecast 

• Memory Forecast 

Both reports have very similar formats. The Filesystem Forecast begins with a selection 
table that provides a list of all the filesystems that are headed towards 100% utilization and 
are expected to reach this level within 90 days. The entries in the table sort by Days to 
Threshold (DTT). Filesystems nearest to the threshold sort at the top of the table. 

In addition to indicating the value for DTT, the selection table shows: 

• Current utilization (the rolling baseline average) 

• Projected utilization 90 days from today


Select an entry in the table to display the following provisioning details: 


• Vendor


• Model


• O/S


• Customer


• Location


• Filesystem utilization threshold level 


From the selection table you may drill down to a daily Grade of Service chart that shows 
increases and decreases in a composite score based on individual scores for utilization (CPU, 
memory, and swap) and queue length. The series of tabbed line graphs below the GOS chart 
track utilization levels and the number of page outs. These graphs track utilization for the 
following resources: 

• Filesystem 

• CPU 

• Memory 

• Swap 

The Memory Forecast begins with a selection table that provides a list of all the systems 
headed towards 100% utilization and projected to reach this level within the next 90 days. The 
entries in the table sort by DDT, lowest number to highest number, or nearest to threshold at 
the top, furthest from threshold at the bottom. In addition to indicating DDT, the selection 
table shows: 

• Current utilization (the rolling baseline average) 

• Projected utilization 90 days from today


Select an entry in the table to display the following details for the system:
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• Vendor 

• Model 

• Operating system 

• Customer 

• Location 

• Memory utilization threshold 

From the selection table you may drill down to a daily Grade of Service chart that shows 
increases and decreases in an overall score throughout the baseline period. The overall score 
is a composite based on individual scores for CPU utilization, memory utilization, swap 
utilization, and run queue length. 

The tabbed charts below the GOS chart provide daily analysis of trends. These charts show 
how the following variables have behaved over the baseline period: 

• Memory utilization 

• CPU utilization 

• Swap utilization 

• Number of page outs 

See below for a sample of the Filesystem Forecast report followed by a sample of the Memory 
Forecast report. 
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10 Exception Hot Spots and QuickViews

This chapter covers the following reports: 

• Exception Hot Spots 

• QuickView 

• QuickView — Near Real Time 

Exception Hot Spots 

The Hot Spots report provides a list of the systems that exceeded at least one threshold 
condition at some time yesterday. Systems that did not exceed any thresholds will not appear 
in this report. This report is particularly useful for identifying systems with the most 
exceptions and looking at exceptions in more detail. The selection table indicates which 
exceptions took place, and how many of each type took place during the 24-hour period that 
ended last night at midnight. Select an entry to display the following data: 

• System-level provisioning details (vendor, model, customer, location, and o/s) 

• Exception thresholds for each resource 

Beneath the selection table is a series of charts that track yesterday’s resource utilization 
levels on an hour-by-hour basis, allowing you to see exactly when exceptions took place. Near 
the bottom of the report you have an Exception Details chart and a Grade of Service chart. 
The first chart shows the data that was captured by each poll, throughout the day. The second 
chart provides an overall grade of service score for each poll. The overall score is a composite 
based on CPU utilization, memory utilization, and queue length. 

QuickView 

The QuickView has a broader scope than Hot Spots. This report includes every system, 
whether or not the system recorded exceptions yesterday. (By default, the selection table is 
limited to 50 rows.) The selection table provides utilization averages for yesterday, covering 
run queue, CPU, memory, swap, and page outs per second. The default sort order is CPU 
utilization. Select an entry in the table to display the following data: 

• System-level provisioning details (vendor, model, customer, location, and o/s) 

• The exception threshold for each resource 

The line graphs below the exception threshold information provide hourly data for each 
resource, allowing you to track increases and decreases throughout the day. 
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QuickView - Near Real Time 

The format of the QuickView - Near Real Time is exactly the same as the QuickView: 

• Selection table that sorts all systems by CPU utilization 

• System-level provisioning details 

• Exception thresholds for each resource 

• Line graphs for each resource 

In the QuickView, you are looking at data for yesterday. In the Near Real Time, you are 
looking at data for the previous six hours. Use the Near Real Time version of the QuickView 
to spot problem areas before the condition begins to affect your users. 

QuickView - Near Real Time - Snapshot 

The format of the QuickView - Near Real Time - Snapshot is exactly the same as the 
QuickView - Near Real Time: 

• Selection table that sorts entries by CPU utilization over the last six hours 

• System-level provisioning details 

• Exception thresholds for each resource 

• Line graphs for each resource covering the last six hours 

In the QuickView - Near Real Time, you are looking at data for the last six hours. In the 
Snapshot version of the Near Real Time you are looking at the same data, but only for the 
specific systems you specify when you open the report. Use the Snapshot version of the Near 
Real Time report whenever you know in advance exactly which system or systems you are 
interested in. 
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11 Top Ten Repor ts

System Resource contains two Top Ten reports: 

• Top Ten (Exception Volume, CPU Utilization, Filesystem Utilization) 

• Top Ten Transactions 

Both reports perform a ranking function. The first one contains three tables and no graphs or 
charts. This report brings into focus yesterday’s exception volume, yesterday’s CPU 
utilization, and yesterday’s filesystem utilization. Use this report to spot systems with high 
exception volume, systems with high CPU utilization, and systems with high filesystem 
utilization. 

In addition to ranking systems, each table in this report provides the following provisioning 
details: 

• Customer 

• Location 

• Make 

• Model 

• Operating system 

The systems that appear in this report may not be exceeding thresholds and generating 
exceptions. The volume and utilization levels that appear in this report may be over threshold 
levels, or they may be well under threshold levels. If you are interested in knowing which 
systems are producing the most exceptions, use the Hot Spots report. 
91 



Chapter 11
92 



Top Ten Reports 93 



Chapter 11
94 



12 Logical System

The SR_LS subpackage collects metrics from the BYLS virtualization class. This class was 
from added to PA in release 4.60. The BYLS metrics collected by PA 4.60 and later   
come these two sources: 

• HPVM 

• AIX LPARS


Installing the Logical System subpackage deploys four reports and one form:


• Logical System Details


• Logical System Availability


• Logical System Physical CPU and Memory


• Logical System “What If”


• Logical System Properties (form)


Use the properties form to modify thresholds. When you modify a threshold, you modify the 
thresholds policy in the SR_LS_Thresholds subpackage. 

LS Details Report 

The system administrator assigns CPU and memory resources to each logical system. 
Although it is clear to the administrator what was assigned to the logical system, it is less 
clear what portion of the assigned amount is actually being used. The LS Details Report 
addresses this problem. This report will help you anticipate bottlenecks in the host system 
operating system that could degrade the performance of virtual machines and the 
applications these machine are running. With access to this data, balancing the vm load per 
server should be much easier. 

If you select a physical system, the report responds by populating the Latest Information 
table with the following details about each LS: 

• Up Time (days) 

• State 

• # CPU 

• RAM (MB) 

• # Disks 

• # LANs 

• Record Last Updated


You will find data about logical CPU, memory, and run queue in the following graphs:
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• Logical CPU % of Logical System (tabs for hourly, daily, monthly) 

• Logical Memory % of Logical System (tabs for hourly, daily, monthly) 

• Logical Run Queue (tabs for hourly, daily, monthly) 

In the graphs, you can look at data for a single LS, or you can look at data for all the logical 
systems at once.  The composite view is the default. By default, the graphs provide a 
composite view of performance covering every logical system associated with the physical 
system. To view data for a single LS, use the LS selector drop-down. 

The value for memory assigned is in the Latest Information table. Because AIX LPARS and 
HPVM do not record CPU metrics the same way (initial CPU unit assigned for AIX LPARS, 
min and max allowed for HPVM), deriving a value for CPU assigned, and adding that metric 
to the Latest Information table, is not feasible. 

Availability Per Logical System 

A logical system with availability problems could indicate that users are having a problem 
running certain applications. Use LS Availability per Logical System to monitor the 
availability of each logical system. 

The Latest Information table is the same as the Latest Information table in the Details 
report. To display hourly, daily, or monthly availability statistics for a single LS, select a 
Logical System in the selection table. The hourly graph contains data for 7 days; the daily 
graph contains data for 30 days. 

LS Physical CPU and Memory Report 

The physical CPU and Physical Memory report shows the impact of individual logical systems 
on physical resources. To populate the Latest Information table, select a physical system. If 
you do not select an individual LS using the LS selector, the following graphs will show a 
composite view of resource consumption: 

• Physical CPU % per LS 

• Physical Memory % per LS 

• Point in Time Physical CPU % 

• Point in Time Physical Memory % 

LS “What If” Report 

The What If report is intended to help administrators spread the LS workload evenly between 
physical machines. For example, if you have two physical machines, and one appears to be 
overloaded, you may need to move some logical systems to the other machine. What you can 
do with this report is add logical systems to the other machine to see what the impact would 
be. In the case of CPU, you the impact may not be that easy to determine, since the other 
physical machine may have a different CPU configuration. However, if the machines have the 
same configuration, then the results shown in this report will be accurate and reliable. 
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A Version History 

Version Release Date Features/Enhancements 

3.00 May 2003 OVPI Object Manager support 
new change forms: 
• Update System 
• Update Filesystem 
new datapipe: 
• SysRes OVPA Datapipe 1.00 

3.00 October 2003 new datapipe: 
SysRes OVPA Datapipe 2.00 

4.00 April 2004 Oracle support 
new reports: 
• CPU Resource Utilization Forecast 
• CPU Performance QuickView 
• Disk Details QuickView 
• Logical Volume Details QuickView 
• Network Interface Details QuickView 
• Process Details QuickView 
• Top Ten Transactions 
• Transactions per System Snapshot 
• System Availability (downtime/uptime) 
• System Inventory 
• Systems Performing Each Application/Snapshot 

4.00 April 2004 changes to existing reports: 
1. SLM—Executive Summary Report 
• Customer selection table: added Total Exceptions 
• Location table: removed Total Vol + Avg Daily Volume 
• Total Exceptions graph: added daily and monthly tabs 
• Total Exceptions graph: removed references to volume 
2. System Volume and CPU Utilization Top Ten Report 
• Highest CPU table: added Queue Length 
• Highest Volume table: added Total Network Util 
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Version Release Date Features/Enhancements 

4.00 April 2004 3. Memory Resource Optimization Report 
• Overutilized Sys Memory table: added Avg Page Outs 
4. CPU Forecast Report 
• DTT selection table: added 30 and 60 day forecast 
5. Memory Forecast Report 
• DTT selection table: added 30 and 60 day forecast 
6. Filesystem Forecast Report 
• DTT selection table: added 30 and 60 day forecast 

4.00 August 2004 new upgrade packages: 
• UPGRADE_SR_3.0_to_4.0.ap 
• UPGRADE_SR_CPU_1.0_to_1.5.ap 
• UPGRADE_SR_DISK_1.0_to_1.5.ap 
• UPGRADE_SR_PROC_1.0_to_1.5.ap 
• UPGRADE_SR_NetIf_1.0_to_1.5.ap 
• UPGRADE_SR_LV_1.0_to_1.5.ap 

4.00 November 2004 new datapipes: 
• OVPA Collection Datapipe 1.00 
• SysRes OVPA Datapipe 2.60 

4.10 June 2005 Report linking 
Launch Point page 
Ad hoc selector reports 
Color-coded graphics in selection tables 
new upgrade packages: 
• UPGRADE_SR_to_4.1 
• UPGRADE_SR_CPU_to_4.1 
• UPGRADE_SR_DISK_to_4.1 
• UPGRADE_SR_PROC_to_4.1 
• UPGRADE_SR_NetIf_to_4.1 
• UPGRADE_SR_LV_to_4.1 
new datapipe: 
• SysRes OVPA Datapipe 2.80 

4.10 May 2006 new versions of sub-packages: 
• SR_DISK 4.20 
• SR_LV 4.20 
• SR_NetIf 4.20 
upgrade packages and defect fixes: 
• UPGRADE_SR_LV_to_4.2 

— QXCR1000329115: defective view 
(RSRV_OVPA_LOGICALVOLUME) 

• UPGRADE_SR_DISK_to_4.2 
— QXCR1000239305: size of prop_disk_name column 

changed from 32 to 255 
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Version Release Date Features/Enhancements 

4.10 May 2006 • UPGRADE_SR_NetIf_to_4.2 
— QXCR1000235473: size of prop_netif_name column 

changed from 32 to 255 
datapipe defect fix: 
• SysRes OVPA Datapipe 3.00 

— QXCR1000247763: config file defect 

4.20 April 2007 new features: 
• Location Independent Reporting (LIR) 
• Copy Policies 
• Top level table of NRT reports no longer shows rate data 
• Long Term Retention (LTR)/Data archiving 
new upgrade packages: 
• UPGRADE_SR_CPU_to_42.ap 
• UPGRADE_SR_to_42.ap 
• UPGRADE_SR_DISK_to_43.ap 
• UPGRADE_SR_LV_to_43.ap 
• UPGRADE_SR_NI_to_43.ap 
• UPGRADE_SR_PROC_to_42.ap 
• UPGRADE_SR_OVPA_to_31.ap 
• UPGRADE_RFC1514_to_41.ap 
defect fixes: 
• QXCR1000187641 
• QXCR1000282592 
• QXCR1000305835 
• QXCR1000317552 
• QXCR1000332277 
• QXCR1000333100 
• QXCR1000349074 
• QXCR1000349423 
• QXCR1000350295 
• QXCR1000351698 
• QXCR1000351779 
• QXCR1000353093 
• QXCR1000353117 
• QXCR1000368670 
• QXCR1000371772 
• QXCR1000380955 
• QXCR1000393303 
• QXCR1000396234 
• QXCR1000409662 
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Version Release Date Features/Enhancements 

4.30 October 2007 new prerequisites: 
• PI 5.30 
• Common Property Tables 3.70 
new enhancement: 
• Copy Policy Enhancement 
new sub-package: 
SR Logical System 1.00 
• LS Details 
• LS Availability 
• LS Physical CPU and Memory 
• LS What-If 
• LS Properties Form 
• LS Thresholds subpackage 
new upgrade packages: 
• UPGRADE_SR_to_43.ap 
• UPGRADE_SR_CPU_to_43.ap 
• UPGRADE_SR_DISK_to_44.ap 
• UPGRADE_SR_LV_to_44.ap 
• UPGRADE_SR_NI_to_44.ap 
• UPGRADE_SR_PROC_to_43.ap 
defect fixes: 
• QXCR1000442694: cust_id is missing in the reports 
• QXCR1000449008: No data found for Application 

Performance Snapshot report. 
• QXCR1000448115: ppSetSysUpByShift does not complete. 
• QXCR1000459760: Some reports fail on Sybase due to 

being modified on Oracle. 
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Version Release Date Features/Enhancements 

4.50  February 2009 new prerequisites: 
•	 PI 5.40 
•	 Common Property Tables 3.90 
new upgrade packages: 
•	 SystemResource_Upgrade_45 (UPGRADE_SR_to_45.ap) 
•	 SystemResourceCPU_Upgrade_to_43 

(UPGRADE_SR_CPU_to_43.ap) 
•	 SystemResource_Disk_Upgrade_to_45 

(UPGRADE_SR_DISK_to_45.ap) 
•	 SystemResource_FileSystem_Upgrade_to_11 

(UPGRADE_SR_FS_to_11.ap) 
•	 SystemResourceLS_Upgrade_to_11 

(UPGRADE_SR_LS_to_11.ap) 
•	 SystemResource_LogicalVolume_Upgrade_to_44 

(UPGRADE_SR_LV_to_44.ap) 
•	 SystemResourceProcess_Upgrade_to_43 

(UPGRADE_SR_PROC_to_43.ap) 
•	 SystemResource_NetInterface_Upgrade_to_44 

(UPGRADE_SR_NI_to_44.ap) 
•	 SystemResource_Thresholds_Upgrade_31_to_32 

(UPGRADE_SR_Thresholds_31_to_32.ap) 
•	 SysRes_RFC1514_Datapipe_Upgrade_to_42 

(UPGRADE_RFC1514_to_42.ap) 
•	 SysRes_OVPA_Datapipe_Upgrade_to_33 

(UPGRADE_SR_OVPA_to_33.ap) 
defect fixes: 
•	 QXCR1000786806: K_OVPA_CONFIG table does not get 

updated. 
•	 QXCR1000790177: Random FSIndexP Key Changing after 

Upgrade to PI 5.20 w/ Hotfixes. 
•	 QXCR1000791798: Discrepancies between Reported 

System Availability and reality. 
•	 QXCR1000793408: Transaction reports are not aggregating 

to hourly data on Central DB server. 
•	 QXCR1000793411: Missing data and information for the 

File System Reports. 
•	 QXCR1000795972: Data for Inventory Report not showing 

on Satellite Server. 
•	 QXCR1000831160: SystemResourceDiskDetails.rep does 

not work with Sybase. 
•	 QXCR1000874593: Delta_time not calculated 

correctly,system resourses threshold values are wrong. 
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B PI Report Packs 

Business Technology 

Application 

Database 

HP Business Process Insight 

HP Internet Services 

HP Network Node Manager 

HP Operations 

HP SiteScope 

IP Telephony 

MPLS VPN 

Networking 

Reporting Solution 

Application Report Pack: 
• WebLogic SPI 
• WebSphere SPI 

Database SPI Report Pack 

BPI Integration Report Pack 

Internet Services Report Pack 

NNM Event & Availability Report Pack 

OVO Report Pack 

SiteScope Integration Report Pack 

• Cisco IP Telephony Call Detail 
• Cisco IP Telephony Gateway Statistics 

MPLS VPN Report Pack 

Infrastructure Usage 

• Interface Reporting 
• Device Resource Report Pack 

LAN/WAN Edge 

• Frame Relay (SNMP only) 
• ATM (SNMP only) 

WAN Core 

• Frame Relay (multiple switch vendors) 
• ATM (multiple switch vendors) 

Traffic Profiling 

• RMON II 

• NetFlow Interface 

• NetFlow Global View 

• IP QoS Report Pack 

• Class-Based QoS 
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Business Technology 

Networking (continued) 

System Resources 

Reporting Solution 

Quality Assurance 

• Cisco Ping Report Pack 
• Service Assurance 
• IP Access Rate 

• System Resource Report Pack 
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C Logical System Metrics

Configuration Class 

GBL_SYSTEM_ID 

GBL_OSNAME 

GBL_OSRELEASE 

GBL_OSVERSION 

GBL_LS_TYPE 

GBL_LS_ROLE 

GBL_NUM_CPU (BYLS_NUM_CPU) 

BYLS_CPU_ENTL 

BYLS_CPU_ENTL_MAX 

Description 

The network node hostname of the system.uname -n 

A string representing the name of the operating 
system.uname -s 

The current release of the operating system. On most Unix 
systems, this is the same as the output from the uname -r 
command. 
AIX: Actual patch level of the operating system. This is 
similar to what is returned by the command: 
lslpp -l bos.rte 

A string representing the version of the operating system. 

The virtulization technology, if applicable. The value of this 
metric is: 
• HPVM on HP-UX host 
• LPAR on AIX LPAR 
Otherwise, the value is: NoVM. 

Indicates whether PA is installed on Logical system or host 
or standalone system. This metric will be either: 
• GUEST 
• HOST 
• STAND 

The number of physical CPUs on the system 

The entitlement or the CPU units granted to a logical 
system at startup. 
AIX SPLPAR: indicates the cpu units allocated by 
hypervisor to a logical system at the time of starting. This 
metric is equivalent to “Entitled Capacity” field of 
lparstat -i command. 

The maximum CPU units configured for a logical system. 
HP-UX HPVM: indicates the maximum percentage of 
physical CPU that a virtual CPU of this logical system is 
guaranteed. 
AIX SPLPAR: equivalent to Maximum Capacity field of 
lparstat -i command. 
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Configuration Class 

BYLS_CPU_ENTL_MIN 

BYLS_CPU_ENTL_UTIL 

BYLS_CPU_MT_ENABLED 

BYLS_CPU_PHYSC 

BYLS_CPU_PHYS_SYS_MODE_UTIL 

BYLS_CPU_PHYS_TOTAL_UTIL 

BYLS_CPU_PHYS_USER_MODE_UTIL 

Description 

The minumum CPU units configured for this logical 

system.

HP-UX HPVM: indicates the minimum percentage of 

physical CPU that a virtual CPU of this logical system is 

guaranteed.

AIX SPLPAR: equivalent to Minimum Capacity field of

lparstat -i command.


Percentage of entitled processing units (guaranteed 

processing units allocated to this logical system) consumed

by the logical system.

HP-UX HPVM host: indicates the logical system’s CPU 

utilization with regard to minimum CPU entitlement. This 

metric is calculated as:

BYLS_CPU_ENTL_UTIL = (BYLS_CPU_PHYSC / 

BYLS_CPU_ENTL_MIN) * 100

AIX: calculated as:

BYLS_CPU_ENTL_UTIL = (BYLS_CPU_PHYSC / 

BYLS_CPU_ENTL) * 100


Indicates whether the CPU hardware threads are enabled 
or not for a logical system. 

This metric indicates the number of physical processors 
utilized by the logical system. 

On an Uncapped logical system, this value will be equal to 
the physical processor capacity used by the logical system 
during the interval. This can be more than the value 
entitled for a logical system. 

The percentage of time the physical CPU was in system 
mode (kernel mode) for the logical system during the 
interval. 
AIX LPAR: value is equivalent to “%sys” field reported by 
the lparstat command. 

Percentage of total time the physical CPUs were utilized by 
this logical system during the interval. 
AIX: equivalent to sum of 
BYLS_CPU_PHYS_USER_MODE_UTIL and 
BYLS_CPU_PHYS_SYS_MODE_UTIL. 
The metric is calculated with regard to the available 
physical CPUs in the pool to which this LPAR belongs to. 

The percentage of time the physical CPU was in user mode

for the logical system during the interval.

AIX LPAR: this value is equivalent to %user field reported 

by the lparstat command.
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Configuration Class 

BYLS_CPU_SHARES_PRIO 

BYLS_CPU_TOTAL_UTIL 

BYLS_HYPCALL 

BYLS_HYP_UTIL 

BYLS_IP_ADDRESS 

BYLS_LS_ID 

BYLS_LS_MODE 

BYLS_LS_NAME 

BYLS_LS_SHARED 

BYLS_MEM_ENTL 

Description 

This metric indicates the weightage/priority assigned to a 
Uncapped logical system. This value determines the 
minimum share of unutilized processing units that this 
logical system can utilize. 
AIX SPLPAR: value is dependent on the available 
processing units in the pool and can range from 0 to 255. 

Percentage of total time the logical CPUs were not idle 
during this interval. This metric is calculated against the 
number of logical CPUs comfigured for this logical system. 

The number of hypervisor calls made by a logical system 
during the interval. 

Percentage of time spent in hypervisor by a logical system 
during the interval. 

This metric indicates IP Address of the particular logical 
system. 

An unique identifier of the logical system. 
HPVM: this metric is a numeric id and is equivalent to VM 
# field of hpvmstatus command. 
AIX LPAR: this metric indicates partition number and is 
equivalent to Partition Number field of lparstat -i 
command. 

This metric indicates whether the CPU entitlement for the 

logical system is capped or uncapped.

HPUX HPVM: metric is always uncapped as maximum 

CPU entitlement (BYLS_CPU_ENTL_MAX) is always

100%.

The value Uncapped indicates that the logical system can

utilize idle cycles from the shared pool of CPUs beyond its 

CPU entitlement.

AIX SPLPAR: same as Mode field of lparstat -i

command.


This is the name of the computer.

HPVM: metric indicates the Virtual Machine name of the 

logical systemand is equivalent to Virtual Machine Name

field of hpvmstatus command.

AIX: value is as returned by the command uname -n (that 

is, the string returned from the "hostname" program).


This metric indicates whether the physical CPUs are 

dedicated to this logical system or shared.

HPUX HPVM: metric is always Shared.

AIX SPLPAR: equivalent to Type field of lparstat -i

command.


The minimum memory configured for this logical system. 
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Configuration Class 

BYLS_MEM_ENTL_UTIL 

BYLS_NUM_CPU 

BYLS_NUM_DISK 

BYLS_NUM_NETIF 

BYLS_RUN_QUEUE 

BYLS_VCSWITCH_RATE 

Description 

The percentage of entitled memory in use during the 
interval. This includes system memory (occupied by the 
kernel), buffer cache and user memory. 

The number of virtual CPUs configured for this logical

system. This metric is equivalent to GBL_NUM_CPU on 

the corresponding logical system.

HPVM: the maximum CPUs a logical system can have is 4 

with regard to HPVM 2.00.

AIX SPLPAR: the number of CPUs can be configured 

irrespective of the available physical CPUs in the pool this

logical system belongs to.


Local disk devices are counted in this metric. 

The number of network interfaces configured for this 
logical system. This also includes the loopback interface. 

The 1-minute load average for processors available for a 

logical system. 

AIX LPAR: the load average is the total number of 

runnable and running threads summed over all processors 

during the interval.


Number of virtual context switches per second for a logical 
system during the interval. 
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D Options for Customizing Reports 

These are some of the way you can customize reports: 

•	 Apply group filters 

•	 Apply constraints 

•	 Modify the time period (so that you can view archive data in archive reports) 

•	 Add customized property data (customers and locations) 

•	 Change the default view of tables and graphs 

Although creating group filters is a task for an administrator, any user looking at a report can 
apply constraints, switch from active data to archive data, and change view options for tables 
and graphs. For details about view options for tables and graphs, see Editing Tables and 
Graphs. 

Group Filters 

You can share reports with customers by configuring PI to generate customer-specific reports. 
You configure PI to generate customer-specific report by creating and applying group filters. 
Creating group filters involves the following tasks: 

•	 Importing custom property information (customers, locations, IP addresses for nodes, and 
host names for nodes) using Common Property Tables 

•	 Creating a group account for all of the users affiliated with a particular customer 

• Creating a group filter for the group account


For more information about group filters, refer to the PI Administration Guide.


Applying Constraints 

When you edit a parameter, you apply a constraint. The constraint removes data you are not 
interested in seeing. If you edit the Customer_Name parameter, data for every customer 
except the customer you typed in the Customer_Name field will drop from the report. If you 
edit the Location_Name parameter, data for all locations except the location you typed in the 
Location_Name field will drop from the report. 

You can apply multiple constraints at the same time. System Resource supports the following 
parameters: 

•	 Customer_Name 

•	 Location_Name 

•	 Device 
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If you are using the Web Access Server to view reports, apply a constraint by clicking the Edit 
Parameters icon at the bottom right-hand corner of the report. When the Edit Parameters 
window opens, enter the constraint in the field and click Submit. 

If you are using the Report Viewer application, apply a constraint by selecting Edit > Parameter 
Values from the menu bar. When the Modify Parameter Values window opens, click Current 
Value. Enter a new value and click OK. 

Viewing Archive Reports 

If you are using the Web Access Server to view reports containing active data, you can switch 
to archive data by following these steps: 

1 Click Preferences. 

2 Expand the Deployed Items folder. 

3 Click View. The View Settings panel opens. 

4 Click the box next to Allow Element Editing. 

5 Click Apply. The system displays the following message: 

You have successfully updated your report view settings. 

6 Click Catalog. 

7 Expand the System folder. 
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8 Expand the SystemResource folder. 

9 Expand the Archive folder. 

10 Double-click any report in the folder. 

11 When the report opens, click the paint icon in the upper right. The Table Edit window 
opens. 

12 Click Absolute and enter a start time and an end time. 

13 Click Submit. 

Adding Customized Property Data 

The reports in System Resource can be populated with the following properties: 

• IP address for the device 

• Host name for the device 

• Name of the customer associated with the device 

• Location associated with the device 
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When this information appears in a report, the report is reading database tables maintained 
by the Common Property Tables package. If you are about to install Common Property Tables 
for the first time, you can import properties by using the batch-mode property import utility 
that comes with Common Property Tables. Once you import properties in batch mode, you 
have two ways to modify existing properties: 

• Use the batch-mode property import utility (edit a file, then import the edited file) 

• Use the change forms that come with Common Property Tables


For details about both approaches, refer to the Common Property Tables User Guide. 
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E Editing Tables and Graphs

Any table or graph can be viewed in several ways. Although the default view is usually 
adequate, you can easily change to a different view. If you are using Report Viewer, right-click 
the object to open a list of view options. If you are using the Web Access Server, follow these 
steps to change the default view of a table or graph: 

1 Click Preferences on the links bar. 

2 Expand Reports in the navigation frame. 

3 Click Viewing. 

4 Select the Allow element editing box. 

5 Click Apply. 

6 Click the Edit icon next to the table or graph. 

View Options for Tables 

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options. 

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens. 

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time. 

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher. 

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens. 
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Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 

View Options for Graphs 

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 
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The following table provides details about each option. 

Option 

Set Time Period 

Change Constraint Values 

Select Nodes/Interfaces 

Displayed Data 

Grid 

Legend 

Style 

Change Max Rows... 

Display Data Table 

Export Element as CSV... 

View in New Frame 

Print Graph 

Function 

Same as the table option shown above. 

Same as the table option shown above. 

Same as the table option shown above. 

For every point on a graph, display data in a 
spreadsheet. 

Add these to the graph: 
X axis grid lines 
Y axis grid lines 
X and Y axis grid lines 

Delete or reposition the legend. 

See the illustrations below. 

Same as the table option shown above. 

See below. 

Same as the table option shown above. 

Opens graph in a Graph Viewer window. 

Same as the table option shown above. 

Style Options 

Select Style to display a list of seven view options for graphs. 
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Style > Area 

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span. 

Style > Stacking Area 

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables. 
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Style > Bar 

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below. 

Style > Stacking Bar 

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten. 
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Style > Plot 

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers. 

Style > Pie 

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day. 

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 
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Display Data Table 

This option changes a graph into a spreadsheet. 

View in New Frame 

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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F Uninstalling the SR Report Pack

Uninstalling System Resource also uninstalls any datapipe that depends on System Resource. 

Follow these steps to uninstall the System Resource Report Pack:


1 Log in to the system. On UNIX systems, log in as root.


2 Stop OVPI Timer and wait for processes to stop running.


Windows NT: 

a Select Control Panel > Administrative Tools > Services 

b Select OVPI Timer from the list of services.


c From the Action menu, select Stop.


UNIX: As root, do one of the following:


— HP-UX: sh /sbin/init.d/ovpi_timer stop 

— Sun: sh /etc/init.d/ovpi_timer stop 

3 Launch Performance Insight and start Package Manager. The Package Manager welcome 
window opens. 

4 Follow the on-screen instructions for uninstalling packages. When the Selection Summary 
window opens, select System Resource. When the uninstall process finishes, a package 
removal complete message appears. 

5 Click Done to return to the Management Console. 

6 Restart OVPI Timer. 

Windows NT: Select Settings > Control Panel > Administrative Tools > Services 

UNIX: As root, type one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer start


Sun: sh /etc/init.d/ovpi_timer start
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Index

A 
adding customized property data, 117


AIX LPARS, 95


Allow Element Editing (archive reports), 116


archive reports, 116


C 
change max rows option, 121


collection_manager, 18


configuring distributed systems, 22, 55
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grid options, 121


group_manager, 18


group filters, 115
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integration with NNM, 14
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L 
legend options, 121


logical system threshold limits, 59
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node configuration (exclusive per datapipe), 22
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options for viewing reports, 20


PA 4.6, 95


OVPA Collection Datapipe, 22, 27
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pa_discovery.data file, 28


polling policies, 17, 20


R 
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report parameters, 115
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satellite servers, 55


SNMP discovery, 28


SR_CPU sub-package 4.2, 24

129 



SR_DISK sub-package 4.30, 24


SR_LS_Thresholds 1.00, 24


SR_LS sub-package 1.00, 24


SR_LV sub-package 4.30, 24


SR_NetIf sub-package 4.30, 24


SR_PROC sub-package 4.20, 24


style options for graphs, 121


SysRes OVPA Datapipe, 22, 29


SysRes RFC 1514 Datapipe, 21, 27
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Use Absolute Time, 119
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We appreciate your feedback! 

If an email client is configured on this system, by default an email window opens when you 
click on the bookmark “Comments”. 

In case you do not have the email client configured, copy the information below to a web mail 
client, and send this email to docfeedback@hp.com 

Product name:


Document title:


Version number:


Feedback:
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